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Trademarks
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UNIX is a registered trademark in the United States and other countries licensed exclusively through
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About This Book

This book describes how to set up and use IBM Softcopy Librarian. The Softcopy Librarian (SCL, program
number 5648-032) lets you transfer shelves, books, PDFs, Knowledge Center content and other
publications to a repository and manage them there. One or more repositories can be set up on:

« A z/0OS host running IBM TCP/IP FTP
« An 0S/390 host running IBM TCP/IP FTP
« A Unix-like server, accessible through FTP

« A LAN hard drive, accessible using Copy commands

 Alocal PC hard drive, accessible using Copy commands

The Softcopy Librarian runs on a Windows 7 or Vista workstation.

To use the Softcopy Librarian, you would do the following:

1.
2.
3.

Set up at least one repository for softcopy files that you want to manage.
Create a catalog for that repository.

Transfer files from a CD, from a local hard drive on your workstation, from the IBM PUBLIB Web site, or
from any other Web site that can support the Softcopy Librarian.

When you transfer files from any of these sources to your repository, the Softcopy Librarian compares
what you want to transfer with the catalog.

. The Softcopy Librarian then lists the items that you do not have in your repository and the items that

have changed since the last time you updated the repository.

. You can select and transfer only those items that you do not have or that have been updated.

The Softcopy Librarian lists everything that is in your repository and lets you delete objects that have
been replaced or that are no longer needed.

What's Changed in This Book

This section summarizes the major changes made in the current edition of the Softcopy Librarian: User's
Guide.

Publishing History

The following table shows the publication history of this manual:

Table 1: Publication History

Product Version/ Edition Date Order Number
Release Service Level

V5 Eighteenth August, 2015 GC23-3414-17
V4.3 Sevententh January, 2009 GC23-3414-16
V4.2 Sixteenth July, 2007 GC23-3414-15
V4.2 Fifteenth September, 2004 GC23-3414-14
V4.2 Fourteenth June, 2004 GC23-3414-13
V4.2 Thirteenth October, 2003 GC23-3414-12
V4.2 Twelfth August, 2003 GC23-3414-11
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Table 1: Publication History (continued)

Product Version/ Edition Date Order Number
Release Service Level

V4.l Eleventh December, 2002 GC23-3414-10
V4.1 Tenth July, 2002 GC23-3414-09
V4.l Ninth September 2001 GC23-3414-08
Vv4.0C Eight March 2001 GC23-3414-07
V3.5B Seventh September 2000 GC23-3414-06
V3.5 Sixth June 2000 GC23-3414-05
V3.4 Fifth December 1999 GC23-3414-04
V3.2D Fourth September 1999 GC23-3414-03
V3.2 Third June 1999 GC23-3414-02
V3.1 Second March 1999 GC23-3414-01
V3.0 First September 1998 GC23-3414-00

The current edition is listed first.

Changes Made in the Eighteenth Edition

New Information

Support for IBM® Knowledge Center for z/0S°® and Knowledge Center content delivery.

Removed references in this publication to support for Windows XP.

Added references in this publication to support for Windows 7.

Changes Made in Previous Editions

For a summary of the changes made in the previous editions of this book, refer to Appendix E, “Summary

of Changes Made in Previous Editions,” on page 71.

About This Book ix



Chapter 1. Introducing the Softcopy Librarian

This section introduces and summarizes:

« What the IBM Softcopy Librarian can do for you
« How to install the IBM Softcopy Librarian

How to set up a repository
« How to create a catalog for your repository

How to upload shelves, books, and . zip files of Knowledge Center plugins
« How to maintain your repository

What the Softcopy Librarian Can Do for You

The IBM Softcopy Librarian V5 provides you with the ability to manage softcopy shelves and associated
publications. These can either be provided by IBM or built using the IBM BookManager shelf architecture
and BookManager Build or Builder application for softcopy publications.

The Softcopy Librarian provides these capabilities:

« Manages the following types of files and file types (MVS and Local Unix)
Books (BOOK and .BOO files)

Shelves (BKSHELF or .BKS files)

Extended Shelves (XKSHELF or .XKS files)

Shelf Indexes (BKINDEX or .BKI files)

PDFs (PDF files)

IBM Knowledge Center for z/OS content (.ZIP files of plugins)
 Active Management, in addition to transferring files, also includes:

— Maintaining a catalog of the contents for each of your repositories

— Comparing what's currently in your repositories with new sources of shelves, books, PDFs,
Knowledge Center content and other publications

— Providing you with the comparative status of the items in the source in relation to the contents of your
current repositories

— Updating the catalogs whenever you transfer new shelves, Books, PDFs, Knowledge Center content
and other publications to your repositories

— Identifying items in your repositories that can be removed because there are newer versions of these
items also in your repositories

« Set up and maintain repositories using a variety of sources. You can obtain and transfer content and
associated publications from:

CD collections from IBM

OEM (Original Equipment Manufacturers) CD Collections

The IBM PUBLIB Web site (over the Internet)

A local hard disk

Other Web sites (that provide support for the Softcopy Librarian)

« Tracking of New and Updated Knowledge Center content, as well as Updated shelves and associated
publications

© Copyright IBM Corp. 1997, 2015 1



The Softcopy Librarian keeps a catalog of all the Knowledge Center content, as well as the shelves and
associated publications that you send to your repository from any level of a CD, from your local hard
drive, from the IBM PUBLIB Web site, or any other Web site that supports the Softcopy Librarian. When
a new level of a shelf or Knowledge Center content arrives, on a new CD or downloaded from a web site,
the Softcopy Librarian compares it and its contents with the catalog and shows you whether it's brand
new or whether it's changed since the last level you received. You now have a way to see at a glance
which Knowledge Center content or shelves on a CD or on a supported web site are currently in your
host repository.

« Support for 0S/390 and z/OS Repositories
The Softcopy Librarian supports repositories in sequential data sets for all content other than
Knowledge Center content. You can use BookManager READ/MVS to access the books, shelves and
other publications on your 0S/390 or z/OS host. All communication with the host is done via FTP.
— Current support is for IBM TCP/IP FTP only.

— BookManager READ/MVS requires service for APAR PQ75262 when, or before you upload extended
shelves (XKS files).

» Support for 0S/390 and z/OS Unix System Services Repositories

The Softcopy Librarian supports repositories in either hierarchical file systems or sequential data sets.
You can use BookManager BookServer for z/OS or 0S/390, or Library Server to access the books,
shelves, and other publications, or use IBM Knowledge Center for z/OS to access Knowledge Center
plugins on your z/OS or 0S/390 host or server. All communication with the host is done via FTP.

— Current support is for IBM TCP/IP FTP only.

« Support for Unix-like Repositories
The Softcopy Librarian supports repositories on Unix-like servers. You can use BookManager
BookServer/Library Center for AIX to access the books, shelves, PDFs and other publications on your
Unix-like server. All communication with the host is done via FTP.
— Current support is for IBM TCP/IP FTP only.

« Support for PC/LAN Repositories
The Softcopy Librarian supports repositories on LAN server or local personal computer hard drives that
can be accessed as a drive letter on Windows systems. The drive must be a valid target for a Copy
command. You can use the BookManager Softcopy Reader to access the shelves, books, PDFs and other
publications on your LAN server or PC workstation. Although Softcopy Librarian can maintain

Knowledge Center content on an PC/LAN repository, Softcopy reader does not support Knowledge
Center content.

« Support for PDF files
The Softcopy Librarian supports PDF files and Extended Shelves to organize them, obtained from either
the "PUBLIB" web site, or the Collection "CD."

« READ/MVS requires service for APAR PQ75262, if you place extended shelves in a z/OS or PS/390
sequential dataset repository.

- Managing Your Own and Other Manufacturer's Books, PDFs, . zip files and other publications

The Softcopy Librarian will let you track shelves, books, PDFs, Knowledge Center content and other
publications that you create or that you might receive with product from companies other that IBM.

Note: CD Collections of softcopy shelves and associated publications from others - OEM (Original
Equipment Manufacturers) - must be built using the IBM BookManager shelf architecture (for shelves
containing books), or the extended shelf architecture (for shelves containing PDFs) and BookManager
Build or builder application for the softcopy publication. Use IBM BookManager Softcopy Reader or
Shelf Organizer to build extended shelves.

« Available on all IBM Online Library CDs and from the IBM Web Site

The Softcopy Librarian is available, at no cost, on all IBM Online Library collections and on other IBM
product CDs.

2 Softcopy Librarian: User's Guide



The latest version of the Softcopy Librarian is also available and can be downloaded from the following
IBM Web site: http://www.ibm.com/software/applications/office/bkmgr/librarian.html

Some Terms You Should Know

Here are some Softcopy Librarian terms with which you should become familiar:

Source

Is the place from where you can obtain the Knowledge Center content or the shelves and associated
publications that you want to place into your repositories. Sources can include:

« CD drive for CD collections from IBM or other manufacturers
« The Internet for connection to IBM's online library or other online libraries

« Alocal hard drive or server for Knowledge Center content and for shelves and associated
publications you can create

Repository

Is the place where your softcopy items are stored. During Softcopy Librarian setup, you specify where
the repository is located and how to access it. You can define multiple repositories in these locations:

« 0S/390 or z/OS host sequential data sets - identified by a high-level qualifier

« 0S/390 or z/OS Unix System Services hierarchical file system - identified by an HFS directory,
« A Unix-like server - identified by a Unix-like directory

« Ahard drive on a local PC or LAN server - identified by a PC directory

Catalog

Is a Softcopy Librarian file that lists the softcopy items contained in a Softcopy Librarian repository.
You can create a catalog when you set up a new, empty repository. However, the catalog is
automatically updated every time you use the Softcopy Librarian to update your repository. The
Softcopy Librarian builds a catalog by querying the contents of the directory or the high-level qualifier
(HLQ) specified during the setup of the repository and then builds the catalog information.

Overview of Setting Up the Softcopy Librarian

In general, the steps that you must plan for are:

1.

2.

4.

Determine whether your hosts and workstations meet the hardware and software requirements for
using the Softcopy Librarian. Refer to Chapter 2, “Hardware and Software Requirements,” on page
5.

Install the Softcopy Librarian on your workstation. Refer to Chapter 4, “Installing the Softcopy
Librarian,” on page 11.

. Set up one or more repositories. For 0S/390 or z/OS repositories in sequential data sets, refer to

Chapter 8, “Setting Up a z/OS or 0S/390 Host Repository Using Sequential Data Sets,” on page 27.
For 0OS/390 or z/OS repositories in 0S/390 or z/OS Unix System Services hierarchical files, refer to
Chapter 9, “ Setting Up a z/OS or 0S/390 Host Repository Using the Unix System Services HFS,” on
page 33. For a Unix-like repositories, refer to Chapter 10, “ Setting Up a Unix-like Repository,” on
page 37. For a PC or LAN repositories, refer to Chapter 11, “ Setting Up a PC/LAN Repository,” on

page 41.

Create a catalog for each repository. Refer to Chapter 12, “ Creating and Recreating the Catalog for
Your Repository,” on page 45.

. Transfer content and associated publications to your repositories. Refer to Chapter 14, “Maintaining

Your Repositories,” on page 51.

. Maintain the repositories by identifying, replacing and/or deleting softcopy items. Refer to Chapter 14,

“Maintaining Your Repositories,” on page 51.
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Overview of Using the Softcopy Librarian

After you have installed and set up the Softcopy Librarian, you can use it to help you:

« Compare the contents of any source (that is, a CD you received, the contents of a supported Web site, or
the hard drive of a server) with the catalog for any of your repositories.

This comparison will show you which shelves, Books, PDFs, Knowledge Center content and associated
publications on that source are new, updated, installed, partial, or downlevel.

New
Have not appeared on that source previously and are not currently in your repository.

Updated
Are at a more recent level than the ones in your repository; you installed them from a previous
release of this collection, and they have been updated on this collection.

Unchanged
Were included in the previous release of this collection, but you did not install them in your
repository; they have not been updated since then.

Installed
Are already in your repository; you installed them previously, and they have not been updated since
then.

Partial
Are already in your repository; you installed them previously, but the shelves in your repository are
missing books.

Downlevel
Are at an earlier level than the ones your repository. This usually occurs if you are viewing a CD that
is older than the previous CD you used.

 Upload only new or updated shelves and Knowledge Center content, or partial shelves to your
repository.
This saves you time and DASD space and still keeps your repository up to date. The catalog is updated
automatically whenever you upload to the repository.

« Maintain your host repository.

The Softcopy Librarian shows you which shelves or Knowledge Center content in your repository can be
replaced by the new and updated shelves or . zip files that you just transferred.

You can:

— List the Books, PDFs or other publications in a shelf
— See which Books, PDFs or other publications if any, are missing from any of the shelves
— See which Books, PDFs, and other publications are "orphaned," that is, not in any shelf.

All this makes it easy for you to delete the shelves, Books, PDFs, Knowledge Center content or other
publications that have been replaced or are no longer needed.
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Chapter 2. Hardware and Software Requirements

This chapter describes the hardware and software required to install and use the Softcopy Librarian on
your hosts and workstations.

Hardware and Software Requirements for Your Workstation

This section describes the software and hardware requirements for the workstation on which you will do
the following:

« Install the Softcopy Librarian.

« Create a catalog of softcopy that resides in your repositories.

- Transfer softcopy shelves, books, PDFs, Knowledge Center content and other publications to your
repository.

It must have the following hardware and software:

A workstation that consists of:

« A 1GHz equivalent or faster processor.
« One of the following operating systems:

— Windows 7 or Windows Vista
« To use 0S/390 or z/0S repositories, a TCP/IP link that supports FTP communications with your host.
— Current support is for IBM TCP/IP FTP only.

« To use LAN server repositories, a network connection which allows you to access the LAN server as a
drive letter.

« To use local PC repositories, no additional requirements.
« To use CD-ROM collections as a source, a CD-ROM drive.

« To use the Internet as a source or to check for updates to the Softcopy Librarian, an Internet
connection.

« A minimum of 100MB of space on your hard drive.

Hardware/Software Requirements for 0S/390 or z/0S Host Repositories

This section describes the software and hardware requirements for an 0S/390 or z/OS host on which you
will maintain one or more softcopy repositories.

Your host must have the following hardware and software:
A Host system that consists of:
- One of the following operating systems:
- z/0S
- 0S/390
- MVS
« A TCP/IP link that supports FTP communications from your workstation
Current support is for IBM TCP/IP FTP only.

Your destination host must be inside your firewall, the Softcopy Librarian does not provide proxy
support for this transfer.
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- Sufficient DASD space for the Knowledge Center content, shelves, Books, PDFs and other publications
that will reside in your repositories.

« If you plan to:
— Use sequential dataset repositories, and
— store extended shelves in them, and
— allow your users to use READ/MVS

Then you must install service for READ/MVS APAR PQ75262, to prevent READ/MVS from listing
Extended Shelves in its List of Shelves (READ/MVS does not currently support extended shelves).

Hardware and Software Requirements for a Unix-like Repository

This section describes the software and hardware requirements for a Unix-like server on which you will
maintain one or more softcopy repositories.

Your server must have the following hardware and software:
« One of the following operating systems:
- AIX
— Linux
— Any other Unix type operating system
« A TCP/IP link that supports FTP communications from your workstation
Current support is for IBM TCP/IP FTP only.

Your destination server must be inside your firewall, the Softcopy Librarian does not provide proxy
support for this transfer.

« Sufficient DASD space for the shelves, Books, PDFs and other publications that will reside in your
repositories.

Hardware and Software Requirements for Your PC or LAN Repository

This section describes the software and hardware requirements for a PC or LAN on which you will keep
your softcopy repositories.

« You must be able to access the repository's directory as a drive letter.

« Sufficient DASD space for the Knowledge Center content, shelves, Books, PDFs and other publications
that will reside in your repositories.

If you meet the requirements for installing and using the Softcopy Librarian, when you are ready, you can
continue with the information in Chapter 3, “Planning for Your Repositories,” on page 7 to help plan
your repositories.
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Chapter 3. Planning for Your Repositories

This chapter discusses what you will need to know and some of the decisions that you must make in
preparation for setting up your own repositories of shelves, books, PDFs, Knowledge Center content and
other publications.

Note: In addition to, or instead of, setting up your own repositories, you can access the IBM Online Library
on the Internet at this URL:

http://www.elink.ibmlink.ibm.com/publications/servlet/pbi.wss

You need only a browser to access the entire z/0S, 0S/390, z/VM, VM, and VSE libraries.

What Does the Softcopy Librarian Manage?

The Softcopy Librarian actively manages the following types of files:
« BookManager files and file types (MVS and Local UNIX)

Books (BOOK or .BOO files).

Shelves (BKSHELF or .BKS files).

Extended Shelves (XKSHELF or .XKS files).

Shelf indexes (BKINDEX or .BKI files).

- PDFs (PDF files).

« Knowledge Center for z/OS content (.ZIP files of plugins)

Active management involves not just transferring files to your repositories, it also includes:

- Maintaining a catalog of the contents for each of your repositories.

- Comparing what's currently in your repositories with new sources of shelves, books, PDFs, Knowledge
Center content and other publications.

« Providing you with the comparative status of the items in the source in relation to the contents of your
current repositories.

- Updating the catalogs whenever you transfer new shelves, books, PDFs, . zip files and other
publications to your repositories.

- Identifying items in your repositories that can be removed because there are newer versions of these
items also in your repositories.

How Many Repositories Might I Need?

The simplest arrangement is one repository that anyone can access. You must define at least one
repository for the Softcopy Librarian to function.

You might need more than one repository depending upon several factors, which can include:
« All your users do not have access to the same host or server.

« Even if they are on the same host they may not have access to the same LPAR.

» You have a large number of Books, PDFs, Knowledge Center content and other publications that are
easier to manage in unique sets, for example, IBM and non-IBM.

- If you are migrating from one version or release of a system to another, you might want to keep the
Books, PDFs, Knowledge Center content and other publications in separate repositories to make it
easier to delete the older set.
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- If you are running a test release of your system along with your production release, you might want to
keep the two separate from each other.

Where Can I Locate My Repositories?

You can set up one or more host repositories of softcopy shelves, books, PDFs, Knowledge Center content
and other publications in any of the following places:

* On z/0OS or 0S/390 hosts:

— In sequential data sets (except for Knowledge Center content)
— Inthe hierarchical files (HFS) of Unix System Services

« On Linux, AIX or other Unix-like servers

« On LAN servers

= On local workstations

What Information Must I Gather before I Can Define a Repository

You must provide the following information when you define your repository:
- The arrangement of your repositories.

— How many you plan to have

— What they will contain

— Where they will be located
« For all repositories: A name for each new repository.

Note: This name can be anything you want. It is the name that the Softcopy Librarian uses on your
workstation to identify your repositories.

« For host and Unix-like repositories only: The name or IP address and the user ID and password you
use to access your host or server.

- For all repositories: High-level qualifiers or directories, which will contain these files:
Book (.BOOK or .BOO)

Index (.BKINDEX or .BKI)

PDF (.PDF)

Shelves (BKSHELF or .BKS)

Extended Shelves (.XKSHELF or .XKS)

Knowledge Center content

Restriction: Knowledge Center for z/OS content must be stored in directories and cannot be stored in
sequential datasets.

Note: For host repositories in sequential data sets only: Your shelves and books do not require unique
HLQs. For example, if your BookManager code is installed under IBMBK, then the shelves and related
publications could be installed under IBMBK.SOFTCOPY.

« For host repositories in sequential data sets only

A high-level qualifier for the Softcopy Librarian's shelf list.

The type of DASD device you are using
The block size for that DASD device (provided)
The volume in which the data sets will reside

For SMS users only: The applicable data, management, and storage classes that you are using
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« For host, Unix-type, and LAN server repositories only Any FTP commands required by your location to
transfer the shelves and associated publications from the workstation to your host or server.

Take the Next Step

When you are ready to create your repositories, continue with the instructions in Chapter 8, “Setting Up a
z/0OS or 0S/390 Host Repository Using Sequential Data Sets,” on page 27, Chapter 9, “ Setting Up a z/0OS
or 0S/390 Host Repository Using the Unix System Services HFS,” on page 33, Chapter 10, “ Setting Up a
Unix-like Repository,” on page 37, or Chapter 11, “ Setting Up a PC/LAN Repository,” on page 41.

Planning for Your Repositories 9
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Chapter 4. Installing the Softcopy Librarian

This chapter describes:

« Where you can find the Softcopy Librarian installation package.

« How to determine which version is available for download.

« How to determine whether an updated version is available.

« How to install the Softcopy Librarian on Microsoft Windows 7 or Windows Vista workstation.

Locating the Softcopy Librarian installation package

The installation package is located on the CD-ROM containing tools, which is part of the IBM Online
Library collections. The package is also located on the DVD, which is part of the IBM Online Library DVD
collections. The package, in a file named EBRSCLWJ.EXE, is in the SCL directory.

\SCL\EBRSCLWJ . EXE

The latest version of the install package for Windows is also available at this Web address:

http://www-01.ibm.com/software/applications/office/bkmgr/librarian.html

Determining If a Later Version Is Available for Download

From time-to-time, an updated version of the Softcopy Librarian is made available for download from the
IBM Softcopy Librarian Web site. If you are using a Windows workstation, you can check automatically or
manually if a later version than the one you currently have installed on your workstation is available. You
might want to do either of these checks occasionally.

Checking for a Later Version Automatically
To check automatically, do the following:
1. On the Softcopy Librarian's menu bar, select Help.
2. In the Help pull-down menu, select Check for Updates (automatic).

The Check for Updates (automatic) choice will compare the version that you have installed with the
version that is currently available at the IBM PUBLIB Web site.

3. If there is a later version available at the Web site, you will be asked if you want to download it. If you
do, click OK.

If you choose to download it, you will also be asked if you want to install it.
4. If you want to install the new version, click OK.

If you choose to install it, follow the instructions in “Installing the Softcopy Librarian on a Windows
Workstation” on page 12.

Note: If, because of your firewall, the Softcopy Librarian cannot perform the automatic check, you can use
the manual check.

Checking for a Later Version Manually
To check manually, do the following:

1. Locate the Check for Updates (manual) choice. Do one of the following:
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« From the Windows desktop, go to Start > Programs > IBM Softcopy Librarian V5 > Service > Check
for Updates (manual).

- From the Softcopy Librarian's menu bar, select Help > Check for Updates (manual).

The Check for Updates (manual) choice, presents you with an HTML page containing a link to the
Softcopy Librarian's Readme file.

2. Click on the link to the Readme file and look at the version listed.
The first line of the Readme contains the version number.

3. Compare the version listed in the Readme with the version that you have installed.
The Readme also explains how to determine which version you have installed.

4. If there is a later version available on the Web site, you can download the Windows version of the
Softcopy Librarian install package.

Installing the Softcopy Librarian on a Windows Workstation

To install the Softcopy Librarian on a Windows workstation, do the following:

1. Locate the install package EBRSCLWJ.EXE and invoke it from Windows Explorer, the Start->Run
prompt, or a command prompt.

The InstallShield Wizard window appears. When the Softcopy Librarian code is unpacked, the
Choose Destination Location window appearsinthe IBM Softcopy Librarian Setup
screen.

2.Inthe Choose Destination Location window, you can accept the default destination
C:\Program Files\IBM\IBM SoftCopy Librarian V5 orchoose another. When you are ready,
click the Next> button.

The Start Copying Files window appears to confirm your choices.
3. Inthe Start Copying Files window, click the Next> button.

A progress indicator shows the Softcopy Librarian files being installed. When the installation is
complete, the Installation Wizard Complete window appears.

4.1Inthe Installation Wizard Complete window, click the Finish button.
After you have installed the Softcopy Librarian code, you are ready to start the Softcopy Librarian and

prepare your host or server for setting up a repository. Continue with the instructions in Chapter 5,
“Starting the Softcopy Librarian,” on page 13.
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Chapter 5. Starting the Softcopy Librarian

This chapter describes how to start the Softcopy Librarian on a Windows workstation.

Starting the Softcopy Librarian From a Windows Workstation

To start the Softcopy Librarian, do the following:

1. Double-click the Softcopy Librarian icon on the Windows desktop or go to Start > Programs > IBM
Softcopy Librarian V5 > Softcopy Librarian. The Softcopy Librarian window appears. If you are
starting the Softcopy Librarian for the first time: The SCL - First Time Usage window will also
open.

2. Set up a default source for your CD-ROM drive: type the drive letter for your CD-ROM drive in the CD-

ROM Drive field.

The Softcopy Librarian will create a default source using your CD-ROM drive.
3. Click on the Define CD Source button.

The default source will be named CD-ROM - x\ drive.

If you have previously installed and set up the Softcopy Librarian and know how to use it, you can
continue with the instructions in Chapter 14, “Maintaining Your Repositories,” on page 51.

If you are not familiar with the Softcopy Librarian window and how to use it, you can continue reading

“How You Can Use the Softcopy Librarian Main Window” on page 13 for a description of the main
window and what you can do next.

How You Can Use the Softcopy Librarian Main Window

The Softcopy Librarian main window contains a menu bar and several windows. The following
descriptions will help you become familiar with the location and contents of the items in the main
window.

The Menu Bar
The menu bar contains the following choices:
- File
This selection contains the following choice:
- Exit
This closes the Softcopy Librarian.
- Settings
This selection contains the following choice:
— Proxy
This permits you to define the type of Internet connection that you are using:

- Direct - without a firewall
- Proxy - with a firewall
— Trace
For debugging purposes only: Do not select this choice unless instructed do to so by IBM support.
e Window
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This selection always contains the following choices:

Tile

This arranges the open windows in a tiled arrangement, that is, all the windows are open and fit side-
by side in the available space.

Cascade

This arranges the open windows in a cascaded arrangement, that is, all the windows are placed on
top of each other with at least their titles showing.

Minimize all

This temporarily hides each open window from view. A button that will redisplay each window
appears at the bottom of the main window.

Maximize all

This redisplays any windows that were minimized and returns them to view. Each window occupies
the entire area of the main window. You can bring any window to the top with its choice in this list.

Messages

This redisplays only the Messages window if it was previously minimized and always makes it the
active window.

Sources and repositories

This redisplays only the Sources and Repositories window if it was previously minimized and
always makes it the active window.

This selection also contains an additional entry, by title, for each source or repository window that you
currently have open.

Source - source-title

This redisplays only the source window named if it was previously minimized and always makes it the
active window.

Repository - repository-title

This redisplays only the repository window named if it was previously minimized and always makes it
the active window.

- Help

This selection contains the following choices:

Getting Started

This is your online help. It provides brief descriptions to help you understand the contents of the
windows and the choices available

User's Guide

This is the Softcopy Librarian User's Guide. It contains a complete description of the Softcopy
Librarian.

About
This gives you a brief description of the Softcopy Librarian program and identifies the version.
Reporting a problem

This provides a way to report any problems that you encounter with the Softcopy Librarian directly to
IBM.

Hints and tips

This contains suggestions and guidelines from the developers concerning the operation and
configuration of Softcopy Librarian.

Check for updates (auto and manual)
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This permits you to check the IBM Softcopy Web site for the latest updates to the Softcopy Librarian
as they become available.

Using the Softcopy Librarian windows

You will also see several windows in the Softcopy Librarian window.

If your have just installed the Softcopy Librarian: the following windows will appear:

The SCL - Getting Started Window

This is the online help that is available to you from the Help choice on the menu bar. If you no longer need
it open all the time, close the Getting Started window, then exit Softcopy Librarian. The program will
remember not to open the Getting Started window when you initiate Softcopy Librarian in the future.

The Messages Window

This records status and errors messages as they are produced by the Softcopy Librarian.

The Sources and Repositories Window

This window usually lists all the sources and repositories that are currently available to you. You can open
any source or repository listed by double clicking on it in the list. At this point, this window will contain
only two default sources - a default CD-ROM drive and a default Internet connection to the IBM Online
Library Web site.

The Column Headings in the Sources and Repositories Window
This window lists the following:
- Type
The type of the entry: Souxce or Repository.
- Title
The titles of the sources and repositories.

Note: You can change the alphanumeric order of each column from ascending to descending and back
by clicking on the heading of the column that you want to reorder.

The Menu Bar
The menu bar contains the following choices:
- File
This selection contains the following choices:
— New
This lets you define a new source or repository.
- Print
This lets you print the list of sources and repositories.
— Synchronize (not available)

This lets you synchronize or merge the contents of two or more repositories. That is, any file in any
repository that is not in any of the other repositories is added to them. All the repositories will be
identical to each other.

- Open
This opens the window of the selected source or repository.
— Create Catalog (Repositories only)

This creates or recreates the catalog for the selected repository.
— Delete
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This deletes the selected source or repository.
— Properties

This opens the Repositories Properties - titleorthe Source Properties - title
window for updating the selected source or repository.

— Update Status: Compared to (Sources only)

This updates the status column for the items on this source in comparison with the contents of one of
your repositories.

— Erase Cache (Repositories only)

This lets you erase the cache if you have made changes to this repository by hand outside of the
Softcopy Librarian.

- Help
This selection contains the following choices:
- Getting Started
This opens the Getting Started window if it is closed.
- User's Guide

This opens the complete Softcopy Librarian User's Guide.

The Source - source-name Window

If you have set up sources or if you have migrated them from a previous version of the Softcopy Librarian,
one or more source windows might appear. This window contains a source of publications that you have
defined regardless of where it is located. The title that you assigned to it appears in the title of the
window. There is one source window for each source to which you currently have access.

You can open a source window by selecting it from the list in the Sources and Repositories window.

The Column Headings in a Source Window
This window lists the following:
- Title
The titles of the shelves and Knowledge Center content available on this source.
- Status

The status of each shelf or Knowledge Center . zip file compared to the contents of one of your
repositories.

Note: If you do not have any repositories defined, the status is "New." for all items listed.
The status of a shelf or Knowledge Center . zip file can be:

New
One of the following occurred:

— This is the first time that this shelf or Knowledge Center . zip file appears on any CD or supported
Web site from this manufacturer, and is, therefore, not currently in your repository.

Note: This status can apply to all IBM CDs and might apply to the CDs of other manufacturer's
who take notice of their previous CDs.

— This shelf appeared on a previous CD; you did not choose to transfer it previously and is,
therefore, not currently in your repository.

You can transfer this shelf or Knowledge Center . zip file now.

Updated
An earlier version of this shelf or Knowledge Center . zip file is currently in your repository. You can
transfer this later version now.
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Note: If you upload this later version, it will not automatically replace an earlier version. You can
choose to delete the earlier version or keep both versions.

Installed
This shelf or Knowledge Center . zip file is currently in your repository. You cannot transfer this
shelf or Knowledge Center . zip file.

Downlevel
A later version of this shelf or Knowledge Center . zip file is currently in your repository. This earlier
version is not in your repository. You can transfer the earlier version now, if you want it. It will not
replace the later version.

Note: This can happen if the filename of the shelf does not conform to the naming conventions for
IBM softcopy files, or if you are currently using a CD that is older than a previous CD from which you
transferred this shelf.

Partial
This shelf is currently in your repository. However, your repository is missing one or more files. This
is transferrable.

Filename

The names of the shelf or Knowledge Center . zip files.

Date

The date the shelf or Knowledge Center . zip file was built.

Size

The total size of all the files in the shelf or Knowledge Center . zip file in MB (megabytes).
Files

The number of files in the shelf.

Note: You can change the alphanumeric order of each column from ascending to descending and back by
clicking on the heading of the column that you want to reorder.

The Menu Bar in a Source Window

The menu bar contains the following choices:

File
This selection contains the following choices:
- Print
This prints a copy of the table that appears in this window.
- Save As
This saves to a file a copy of list that appears in this window
— Update Status: Compare to
This updates the status of the items on this source in comparison with one of your repositories.
- Open
This opens the shelf and displays a list of the associated files (publications) contained in it.
- Send to

This lets you send any of the shelves or Knowledge Center . zip files that you have selected to one of
your repositories.

— Refresh

This refreshes the list if you change sources and automatically does an Update Status to the default
repository.

— Close
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This closes this window.
- Edit
This selection contains the following choices:
- Find Fizrst

This lets you search for any text string in the list.
— Find Next F3
This finds the next occurrence of the text string.
« Options
This selection contains the following choices:
— Select All

This selects all the items in the list.
— Deselect All

This deselects any items that you selected.
— Show New/Updated Ctrl+K

This shows only the items in that list that have a status of "New" or "Updated."
— Show All

This shows all the items in the list.

The Repository - repository-name Window

If you have set up repositories or if you have migrated them from a previous version of the Softcopy
Librarian, one or more repository windows might appear. This window contains one of the repositories
that you have defined regardless of its location. The title that you assigned to it appears in the title of the
window. There is one repository window for each repository to which you currently have access.

If you had a repository window open previously, it will be open when you start the Softcopy Librarian. You
can open a repository window by selecting it from the list in the Sources and Repositories window.

The Column Headings in a Repository Window
This window lists the following:
« Under the Shelves tab:
- Title
The titles of the shelves currently in this repository

Note: If a shelf appears in "red," then it is missing one or more associated publication's files.
— Filename

The names of the files that contain the shelves.
— Replaced by

The filename of a newer version of this shelf that can replace it
« Under the Files tab:

- Title
The titles of the shelves and associated publications currently in this repository

Note: If a file appears in "red," then it is missing from one or more shelves.
— Filename

The names of the files that contain the shelves and associated publications.
— Replaced by
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The filename of a newer version of this shelf and associated publications that can replace it.
Filetype

The filetype of this shelf and associated publications.

Filetypes can be:

BOOK
Book

BKSHELF
Shelf

XKSHELF
Extended Shelf

BKINDEX
Shelf index

PDF
PDF file

Count

The reference count of this shelf index and associated publications.

Positive
Indicates how many shelves currently include these associated publications.
Negative (-)
Indicates how many shelves are missing these associate publications (shown in red), or without
an accompanying number indicates a single shelf.
Zero (0)
Indicates an "orphaned" file that in not part of any shelf.

Note: To save space, repositories managed by the Softcopy Librarian contain only one copy of a
associated publications that are part of more than one shelf.

« Under the Knowledge Center Content tab:

Title

The titles of the Knowledge Center content currently in this repository
Filename

The names of the . zip files that contain the Knowledge Center content
Replaced by

The filename of a newer version of this . zip file that can replace it
Filetype

The filetype of this content

Filetypes can be:

KC .ZIP
A .zip file that contains Knowledge Center content

COLLECTION
A collection of . zip files that contain Knowledge Center content

Note: You can change the alphanumeric order of each column from ascending to descending and back by
clicking on the heading of the column that you want to reorder.

The Menu Bar in a Repository Window

The menu bar contains the following choices:

Note: These choices apply to both the Shelves and Files tabs unless otherwise indicated.
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« Create Catalog - Creates a catalog for the selected repository.
- File

This selection contains the following choices:

— Erase Cache

This lets you erase the cache if you have made changes to this repository by hand outside of the
Softcopy Librarian.

- Print

This prints a copy of the table that appears in this window.
- Save As

This saves to a file a copy of the table that appears in this window
— Update shelves

For z/OS and 0S/390 repositories only: If you update a z/OS or 0S/390 host repository directly from
tape or change it manually, after you make these changes, this updates the data set names in the
shelves so the Softcopy Librarian will recognize them. (For users who typically install files from tape,
this choice replaces the BKSADD EXEC.) The Update Shelves function is done automatically
whenever you run the Create Catalog function.

— Exclude from Shelf (Files tab only)

This excludes missing files from a shelf permanently.

Note: Missing files appear in red in the list of shelves and in the list of files.
— Download from Internet (Files tab only)

This obtains replacement copies from the IBM Internet Library for any files that are missing from a
shelf in your repository.

— Delete
On the Shelves tab: This deletes any shelves that you select.

On the Files tab: This deletes any file that you select. You should only delete files with a reference
count of O (orphan books).

If you delete a file with a reference count higher than 0, you will create one or more partial shelves
that are missing the book you delete.

— Details

This describes the shelf.
— Edit Title (Shelves tab only)

This lets you change the title of any of the shelves that appear in this list.
— Open (Shelves tab only)

This opens the shelf and displays a list of the associated publications in it.
- Send to

This lets you send any of the shelves or publications that you have selected to one of your
repositories.

- Close
This closes this window.
- Edit
This selection contains the following choices:
- Find Fizrst

This lets you search for any text string in the list.
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— Find Next F3
This finds the next occurrence of the text string.
- Options
This selection contains the following choices:
- Select All

This selects all the items in the list.
— Deselect All

This deselects any items that you selected.
— Sort Shelves by Missing Files

Sorts all shelves with missing files to the top.

What to Do Next

If you have just installed the Softcopy Librarian, and this is the first time that you have started it, you
will need to do the following before you can begin to use it:

« If you want to use the Internet as a source, you must define your Internet connection to the Softcopy
Librarian. Refer to Chapter 6, “Setting Up Your Connection to the Internet,” on page 23 for instructions.

« If you did not choose to migrate your previous source and repository definitions, but you want to
continue to use them, you can migrate them at a future time. Refer to Chapter 7, “ Migrating from
Previous Versions of the Softcopy Librarian,” on page 25 for instructions.

- If you want to define new repositories, you must create definitions for them. For instructions, refer to
Chapter 8, “Setting Up a z/0S or 05/390 Host Repository Using Sequential Data Sets,” on page 27 (for
repositories in z/OS or 0S/390 sequential data sets), Chapter 9, “ Setting Up a z/OS or 0S/390 Host
Repository Using the Unix System Services HFS,” on page 33 (in z/OS or 0S5/390 Unix System Services
hierarchical files), Chapter 10, “ Setting Up a Unix-like Repository,” on page 37 (on a Unix-like server),
or Chapter 11, “ Setting Up a PC/LAN Repository,” on page 41 (on a LAN server or personal computer).

If you have previously installed the Softcopy Librarian, and completed all the necessary set up, you are
ready to use it. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for instructions.
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Chapter 6. Setting Up Your Connection to the Internet

This chapter describes how to set up the Softcopy Librarian to connect to the Internet or your intranet.
You might want the Softcopy Librarian to be able to use the Internet:

« As a source from the IBM PUBLIB or other Web sites
 To check for and download newer versions of the Softcopy Librarian from IBM.

Note: If you are accessing repositories on hosts or local servers and you not using an intranet or the
Internet to access them, you do not need a connection to the Internet. However, if you want to check for
updates to the Softcopy Librarian, you will need an Internet connection.

The Softcopy Librarian supports these connections to the Internet:
« Direct connections
For connections to an intranet inside a firewall or for connections to the Internet without a firewall.

Recommendation: We strongly recommend that you set up a firewall between your server and the
Internet.

« Manual proxy configurations

— HTTP servers as proxies
— SOCKS V4 servers as proxies

For connections to the Internet through a firewall.
« Autoproxy configurations

For connections to the Internet through a firewall.

Note: If you are connecting to the Internet through a firewall, your server must already be configured
for access through your firewall.

Your selection of a type of connection and a URL provided for your proxy should match the specifications
in your Web browser.

Note: Please be aware that Softcopy Librarian does not provide user-id/password support when using
Proxy Configuration.

Setting Up an Internet Connection

Reminder: You can check for the type of connection you are using as follows:

Start -> Setting -> Control Panel -> Internet Options ->
Connections -> LAN Settings

To set up an Internet connection, do the following:
1. Start the Softcopy Librarian.
2. On the menu bar in the Softcopy Librarian window, select Settings.
3. Inthe Settings pull-down menu, select Proxies.

The Proxy Settings window appears.
4. 1Inthe Proxy Settings window, do the following:

a. Select the type of connection. Do one of the following:

« For a Direct Connection: Select the Direct connection to the Internet button.

« For a Manual Proxy Configuration: Select the Manual proxy configuration buttonand
supply the path to your proxy and a port number.
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« For an Auto Proxy Configuration: Select the Auto proxy configuration buttonand make
sure that the URL shown points to the correct automatic configuration script.

b. Click on the OK button.

After you have set up your Internet connection, if needed, you are ready to set up your repositories. You
have two possibilities:

« If you are a new user, you are ready to define the repositories that you intend to use. Continue with the
instructions in Chapter 8, “Setting Up a z/OS or 0S/390 Host Repository Using Sequential Data Sets,” on
page 27 (for host repositories using sequential data sets), Chapter 9, “ Setting Up a z/OS or 0S/390
Host Repository Using the Unix System Services HFS,” on page 33 (for host repositories using
hierarchical files), Chapter 10, “ Setting Up a Unix-like Repository,” on page 37 (for Unix-like
repositories), or Chapter 11, “ Setting Up a PC/LAN Repository,” on page 41 (for PC or local
repositories).
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Chapter 7. Migrating from Previous Versions of the
Softcopy Librarian

This chapter describes how to migrate from an older, previous version of the Softcopy Librarian to the
most current version. After you install the current version of the Softcopy Librarian, you can migrate your
existing repository and source definitions that you used with an older version of the Softcopy Librarian.
Migrating these definitions will make them available to the current version of the Softcopy Librarian, and
you will not need to redefine them.

Migrating from V4.1 to V4.2

To migrate from V4.1 to V4.2, do the following:
1. Install V4.2

2. Using the Properties function, update each respository adding XKS and PDF information.
3. Initiate an Erase Cache with a Catalog Create for each defined repository.

Migrating from V4.2 to V4.3 or V4.6

IBM Softcopy Librarian V4.2 is not supported on Windows Vista or Windows 7. If you have installed V4.2
on Windows Vista, you need to uninstall V4.2 before you install IBM Softcopy Librarian V4.3. If you have
installed V4.2 on Windows 7, you need to uninstall V4.2 before you install IBM Softcopy Librarian V4.6.

File location changes: In IBM Softcopy Librarian V4.3, the sources.fil and repository.fil, both now reside in
the output directory. On versions of Microsoft Windows prior to Windows Vista, the default directory for
these files was x: \Program Files\IBM\IBM SoftCopy Librarian V5\output where xis the
drive where IBM Softcopy Librarian is installed.

On Windows 7 and Windows Vista the default directory for these files is x: \Users\<User ID>
\AppData\Roaming\IBM\ibm softcopy librarian\output where xis the drive where IBM
Softcopy Librarian is installed.

For earlier versions of Windows, the sources.fil and repository.fil files were written to the
Program Files directory, but on Windows 7 and Windows Vista, the Program Files directory is read
only by default.

Migrating from V4.3 or V4.6 to V5.0

Procedure
To migrate from V4.3 or V4.6:
1. Install Softcopy Librarian V5.0.

2. Using the Propexrties function, update existing or add new respositories, adding kcContent and
kcProperties information.

3. Runthe Erase Cache and Catalog Create functions for each defined repository.
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Chapter 8. Setting Up a z/0S or 0S/390 Host
Repository Using Sequential Data Sets

You must define at least one host repository for the Softcopy Librarian to be able to manage your softcopy
files. You can set up one or more host repositories using z/OS or 0S/390 sequential data sets. This type of
repository is intended for use with BookManager READ/MVS accessed from a 3270-like terminal or
through a 3270-like emulator session from a workstation. The definition for this type of repository tells
the Softcopy Librarian where to look for the shelves and what FTP commands to use to access the
repository. You can define this type of repository whether or not you already have softcopy files installed
on your host.

This chapter describes:

« Considerations to keep in mind before setting up your repository
« Instructions for preparing your host
« Defining the repository to the Softcopy Librarian

Considerations for Setting Up Your Repository Using Sequential Data Sets

Here are some things you need to know about repositories on a z/OS or 0S/390 host in sequential data
sets:

 You can define your repositories in several ways. For example:

— Define a single repository under one HLQ, into which you would put all your softcopy data sets.
— Define a single repository under multiple HLQs.

You can put your softcopy

- All shelf file types must be under the same HLQ.
- File types can be either under a separate HLQ or combined under an HLQ.
— Define multiple repositories, provided they are each under separate HLQs from each other.

« If you already have a shelf or shelves (BKSHELF and .XKSHELF) data sets for a repository installed
under multiple HLQs, you must delete them and reinstall them under a single HLQ.

« You can place non-softcopy items under HLQs managed by the Softcopy Librarian. The Softcopy
Librarian will ignore them.

- If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must
recreate the catalog.

The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to
recognize your changes.

« The Softcopy Librarian creates a shelf list in the HLQ you specify when you set up your repository. Do
not make any changes to this list. This list is replaced whenever the Softcopy Librarian adds or removes
data sets, so your changes will be lost.

Setup Required at Your z/0S or 0S/390 Host

To set up a repository on your host, you must do the following;:
1. Edit the BookManager Shelf list (BKLSHELF) on your host. Do the following:

a. Make a backup copy of your BookManager Shelf list (the default is EOY.BKLSHELF).
b. Edit the original copy of the EQOY.BKLSHELF Shelf list.
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c. Delete any shelves that you want the Softcopy Librarian to manage.
d. Include an entry for the Softcopy Librarian's Shelf list:

INCLUDE hlq.BKLSHELF

2. For System Managed Storage Users: You can define separate storage classes for the data sets
containing shelves and associated publications. However, ensure that the Shelf data sets in your host
repository are not migrated from DASD to tape.

Note: If you do migrate your data sets to tape, you must issue an HRECALL command to recall the data
sets before you attempt to create your catalog.

You are now ready to define a host repository. Continue with the instructions in “Defining a z/OS or
0S/390 Host Repository” on page 28.

Defining a z/0S or 0S/390 Host Repository

To define a host repository, do the following:

1. On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy
Librarian,” on page 13.)

2. Inthe Sources and Repositories window inthe Softcopy Librarian window, do the
following:

a. Click on File on the task bar.
b. In the pull-down window that appears, click on the New choice.
c. In the pop-up window that appears, click on the Repository choice.
The Repository Properties - New Repository window appears.
3.Inthe Repository Properties - New Repository window, do the following:

a. Type a name for this new repository in the Repository Title field.

Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian
uses on your workstation to refer to your host repository.

b. Select the Location and method of accessing your repository.
« z/0S or 0S5/390 - Sequential Data Sets via FTP

This is the default.
c. Click onthe FTP Logon Information tab or the Next> button.

The FTP logon information window appears.
4.Inthe FTP logon information window, do the following:

a. In the Host: field, type the host name or IP address of your host.

b. Inthe Port: field, type a port number, if you know that you must use a non-standard port number
to connect to your host. Otherwise, leave this field blank.

c. Inthe UsexID field, type your user ID on your host.
d. In the Passwozd field, type your password for this host, if you have a password.
e. Optionally, Click on the Save Password box.

By saving your password, you will not need to enter your password whenever you start the
Softcopy Librarian. If you do not save your password, you must enter it every time you start the
Softcopy Librarian.

f. Inthe FTP site commands field, enter defaults for any other type FTP site commands that your
installation requires. Enter a complete command, for example:

SITE DCB=xxx
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These site commands are typically used for allocating data sets. Type one command per line.
g. Clickonthe File types tab or the Next> button.

The File types window appears.
5.Inthe File types window, do the following:

a. If you want to set the same defaults for your SMS classes, DASD units and volumes, or additional
FTP commands that apply to all file types, Select the DEFAULT - Applies to all filetypes choice
from the list at the top of the window.

Note: All defaults are optional. If you do not provide a value for of any of the items in this window
except SMS classes, no defaults will be set. For SMS classes, if you do not set a default here, any
host settings that are in effect will be used.

If you specify any of these values for the BOOK, BKINDEX, BKSHELF, or Bk1shelf choices, those
values will override the defaults you set here for the DEFAULT choice.

If you do not want to set the same defaults for your SMS classes, DASD units or volumes, or
additional FTP commands that will apply to all file types, continue with the next step.

b. Inthe SMS Data Class field, enter a data class for all file types.

c. Inthe SMS Management Class field, enter a management class for all file types.
d. Inthe SMS Storage Class field, enter a storage class.

e. In the Unit field, enter a default DASD device for your high-level qualifiers.

f. In the Volume field, enter a default volume ID for your high-level qualifiers.

g. Inthe Additional FTP commands field, enter any additional FTP commands.

h. Continue with the next step to define the high-level qualifiers and blocksizes for your repository
and any defaults that you want to apply only BOOK files.

6. Click on the Book choice in pull-down list or the Next button.
7. Do the following;:

a. Required: Inthe High-level qualifier field, type one or more high-level qualifiers for the
books in your repository.

You do not need to include single quotes; they will be provided for you, for example, if you type:

library.ibmbooks
library.ourbooks

It will appear as:

'library.ibmbooks'
'library.ourbooks'

b. Required: In the Blocksize pull-down menu, select the blocksize for the DASD device you are
using for your BOOK data sets.

c. Optional: If you want to assign separate defaults for SMS classes, devices, or FTP site commands
for your BOOK data sets, you can specify values in the remaining fields on this tab. Otherwise, the
defaults that you specified for the DEFAULT choice will be used for these data sets.

8. Click on the BKINDEX choice in pull-down list or the Next button.
9. Do the following;:

a. Required: In the High-level qualifier field, type the high-level qualifier for the shelf
indexes in your repository.

You do not need to include single quotes; they will be provided for you, for example, if you type:

library.ibmindex
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It will appear as:

'library.ibmindex'

Note: Make sure that the data sets under this high-level qualifier contains only softcopy items.

b. Required: In the Blocksize pull-down menu, select the blocksize for the DASD device you are
using for your BKINDEX data sets.

c. Optional: If you want to assign separate defaults for SMS classes, devices, or FTP site commands
for your BKINDEX data sets, you can specify values in the remaining fields on this tab. Otherwise,
the defaults that you specified for the DEFAULT choice will be used for these data sets.

10. Click on the BKSHELF choice in pull-down list or the Next button.
11. Do the following:

a. Required: Inthe High-1level qualifier field, type the high-level qualifier for the shelves in
your repository.

You do not need to include single quotes; they will be provided for you, for example, if you type:

library.ibmshelf

It will appear as:
'library.ibmshelf'
b. Required: In the Blocksize pull-down menu, select the blocksize for the DASD device you are

using for your BKSHELF data sets.

c. Optional: If you want to assign separate defaults for SMS classes, devices, or FTP site commands
for your BKSHELF data sets, you can specify values in the remaining fields on this tab. Otherwise,
the defaults that you specified for the DEFAULT choice will be used for these data sets.

12. Click on the BKLSHELF choice or the Next button.
13. Do the following:

a. Required: In the HLQ field, provide the high-level qualifier for the shelf list that you included in
EOY.BKLSHELF.

b. Optional: If you want to assign separate SMS classes, devices, or FTP site commands for your
shelf list data set, you can specify values for the remaining fields on this tab. Otherwise, the
defaults that you specified on the DEFAULT choice will be used for this data set.

14. Click on the PDF choice in pull-down list or the Next button.
15. Do the following:

a. Required: In the High-level qualifier field, type one or more high-level qualifiers for the
PDFs in your repository.

You do not need to include single quotes; they will be provided for you, for example, if you type:

library.ibmPDFs

It will appear as:
'library.ibmPDFs'
b. Required: In the Blocksize pull-down menu, select the blocksize for the DASD device you are

using for your PDF data sets.

c. Optional: If you want to assign separate defaults for SMS classes, devices, or FTP site commands
for your PDF data sets, you can specify values in the remaining fields on this tab. Otherwise, the
defaults that you specified for the DEFAULT choice will be used for these data sets.

16. Click on the XKSHELF choice in pull-down list or the Next button.
17. Do the following:
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a. Required: Inthe High-level qualifier field, type the high-level qualifier for the shelves in
your repository.

You do not need to include single quotes; they will be provided for you, for example, if you type:

library.ibmxks

It will appear as:
'library.ibmxks'
b. Required: In the Blocksize pull-down menu, select the blocksize for the DASD device you are

using for your XKSHELF data sets.

c. Optional: If you want to assign separate defaults for SMS classes, devices, or FTP site commands
for your XKSHELF data sets, you can specify values in the remaining fields on this tab. Otherwise,
the defaults that you specified for the DEFAULT choice will be used for these data sets.

18. Click on the OK button.
The Softcopy Librarian window reappears with the following changes:

« The Sources and Repositories window now lists the repository that you just defined.

« Anew Repository - repository-name window for the repository will not appear, but you can
open it from the Sources and Repositories window.

You are done defining your repository. You can define additional repositories by repeating these
instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your
repositories. Continue with the instructions in Chapter 12, “ Creating and Recreating the Catalog for Your
Repository,” on page 45.
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Chapter 9. Setting Up a z/0S or 0S/390 Host
Repository Using the Unix System Services HFS

You must define at least one repository for the Softcopy Librarian to be able to manage your softcopy files
You can set up one or more host repositories of softcopy files using the hierarchical file system of z/OS or
0S/390 Unix System Services. This type of repository is intended for use with either:

« BookManager BookServer/Library Server accessed from a workstation through a web browser
- IBM Knowledge Center for z/OS content accessed from a workstation through a web browser

The definition for this type of repository tells the Softcopy Librarian where to look for the softcopy shelves
and what FTP commands to use to access the repository. You can define this type of repository whether or
not you already have softcopy installed on your host.

This chapter describes:

« Considerations to keep in mind before setting up your repository

« Information about your repository that you will need when you set up the Softcopy Librarian on your
workstation

« Instructions for preparing your host
« Defining the repository to the Softcopy Librarian

Considerations for Setting Up a Repository in Hierarchical Files

Here are some things you need to know about repositories in the z/OS or 0S/390 Unix System Services
hierarchical files:

« You can define your repositories in several ways. For example:

— Define a single repository in a single directory, into which you would put all your content and
associated publications.

— Define a single repository in multiple directories.
- All file types must be in the same directory.
- File types can be either in separate directories or in combined directories.
— Define multiple repositories, provided they are each in separate directories from each other.

« If you already have Shelf (.xks) files for a repository installed in multiple directories, you must delete
them and reinstall them in a single directory.

« If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must
recreate the catalog.

The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to
recognize your changes.

« File names for softcopy items are transferred by the Softcopy Librarian in lower case.

Information You Must Gather about Your Repository

You must provide the following information when you define the repository:

« A name by which the repository will be know on your workstation.
« The host name or IP address and your host user ID and password.
« One or more directories that will contain the files.
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« Any FTP commands are required by your location to transfer the associated file types from the
workstation to your host.

- If you are using the repository for IBM Knowledge Center for z/OS, you also need to provide the location
of Knowledge Center content directories and the product properties file directory.

Defining a z/0S or 0S/390 UNIX System Services Host Repository

To define a host repository, do the following:

1.

On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy
Librarian,” on page 13.)

a.
b.
c.

. In the Sources and Repositories window in the Softcopy Librarian window, do the following;:

Click on File on the task bar.
In the pull-down window that appears, click on the New choice.
In the pop-up window that appears, click on the Repository choice.

The Repository Properties - New Repository window appears.

a.

c

.Inthe Repository Properties - New Repository window, do the following:

Type a name for this new repository in the Repository Title field.

Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian
uses on your workstation to refer to your host repository.

. Select the Location and method of accessing your this repository by clicking on the z/0S or

0S/390 - Unix System Service HFS via FTP button.

. Click onthe FTP Logon Information tab or the Next button.

The FTP logon information window appears.

. In the FTP logon information window, do the following:

a. In the Host: field, type the host name or IP address of your host.

. Inthe Poxt: field, type a port number, if you know that you must use a non-standard port number

to connect to your host. Otherwise, leave this field blank.

. Inthe UsexID field, type your user ID on your host.
. In the Passwozrd field, type your password for this host, if you have a password.
. Optionally, click on the Save Passwozxd box.

By saving your password, you will not need to enter your password whenever you start the
Softcopy Librarian. If you do not save your password, you must enter it every time you start the
Softcopy Librarian.

.Inthe FTP site commands field, enter defaults for any other type FTP site commands that your

installation requires. Enter a complete command, for example:

SITE DCB=xxx

These site commands are typically used for allocating data sets. Type one command per line.

. Clickonthe File types tab or the Next button.

The File types window appears.

5.Inthe File types window, do the following:
6. Click on the BOO choice pull-down list or the Next button.
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a. Required: In the Directories containing books field, type the path to the directory in your
HFS that contains your books. For example:

/u/your-ID/books

7. Click on the BKI choice in pull-down list or the Next button.

a. Required: In the Directory containing indexes field, type the path to the directory in your
HFS that contains your indexes. For example:

/u/your-ID/indexes

Note: This can be the same directory that contains your books.
8. Click on the BKS choice in pull-down list or the Next button.

a.Inthe Directory containing shelves field, type the path to the directory in your HFS that
contains your shelves. For example:

/u/your-ID/shelves
b. Click on the OK button.
9. Click on the PDF choice pull-down list or the Next button.

a. Required: In the Directories containing PDFs field, type the path to the directory in your
HFS that contains your books. For example:

/u/your-ID/PDFs

10. Click on the XKS choice in pull-down list or the Next button.

a.Inthe Directory containing shelves field, type the path to the directory in your HFS that
contains your XKS shelves. For example:

/u/your-ID/xkshelves

b. Click on the OK button.

11. If you are setting up the repository for use with IBM Knowledge Center for z/OS, click on the
kcCONTENT choice in pull-down list or the Next button.

a.Inthe Directories containing KC PLUGIN CONTENT field, type the paths to the directories
in your HFS that will contain your Knowledge Center plugins. For example:

/u/your-ID/kccontent

The Knowledge Center plugins you are deploying are either directories or . jax files, depending on
the style in which they had been packaged by the content builder. They will be located in a
subdirectory of the directory specified in this field. The subdirectory name is determined by
Softcopy Librarian based on the name of the collection to which these plugins belong.

b. Click on the OK button.

12. If you are setting up the repository for use with IBM Knowledge Center for z/OS, click on the
kcPROPERTIES choice in pull-down list or the Next button.

a.Inthe Directory containing KC PRODUCT PROPERTIES field, type the path to the directory
in your HFS that will contain your Knowledge Center product . properties files. For example:

/u/your-ID/kcproperties

You must enter only one directory.
b. Click on the OK button.
The Softcopy Librarian window reappears with the following changes:

« The Sources and Repositories window now lists the repository that you just defined.

Setting Up a z/0S or 0S/390 Host Repository Using the Unix System Services HFS 35



« Anew Repository - repository-name window appears with the name you assigned.

You are done defining your repository. You can define additional repositories by repeating these
instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your
repositories. Continue with the instructions in Chapter 12, “ Creating and Recreating the Catalog for Your
Repository,” on page 45.
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Chapter 10. Setting Up a Unix-like Repository

You must define at least one repository for the Softcopy Librarian to be able to manage your softcopy files.
This type of repository is intended for use with BookManager BookServer accessed from a workstation
through a Web browser. The repository definition tells the Softcopy Librarian where to look for softcopy
and what FTP commands to use to access the repository. You can define a repository whether or not you
already have softcopy files installed.

This chapter describes:

« Considerations to keep in mind before setting up your repository
« Defining the repository to the Softcopy Librarian

Considerations for Setting Up Your Repository

Here are some things you need to know about your repository on UNIX server hard drives:
« You can define your repositories in several ways. For example:
— Define a single repository in a single directory, into which you would put all your softcopy files. .
— Define a single repository in multiple directories.
- All shelf file types must be in the same directory.
- File types can be either in separate directories or in combined directories.
— Define multiple repositories, provided they are each in separate directories from each other.
« Ensure you have read/write access to the necessary directories.

« If you already have files for a repository installed in multiple directories, you must delete them and
reinstall them in a single directory.

- If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must
recreate the catalog.

The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to
recognize your changes.

Defining a Unix Server Repository

To define a repository on a Unix server, do the following:

1. On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy
Librarian,” on page 13.)

2. Inthe Sources and Repositories window inthe Softcopy Librarian window, dothe
following:

a. Click on File on the task bar.
b. In the pull-down window that appears, click on the New choice.
c. In the pop-up window that appears, click on the Repository choice.

The Repository Properties - New Repository window appears.
3. Inthe Repository Properties - New Repository window, do the following:

a. Type a name for this new repository in the Repository Title field.

Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian
uses on your workstation to refer to your repository.
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b. Select the Location and method of accessing your this repository by clicking on 0ther UNIX-
like via FTP button.

c. Clickonthe FTP Logon Information tab or the Next> button.
The FTP logon information window appears.

4.Inthe FTP logon information window, do the following:
a. Inthe Host: field, type the IP address of your server.

b. In the Port: field, type a port number, if you know that you must use a non-standard port number
to connect to your server. Otherwise, leave this field blank.

c. Inthe UserID field, type your user ID on your server.
d. In the Passwozxd field, type your password for this server.
e. Optionally, click on the Save Passwozrd box.

By saving your password, you will not need to enter your password whenever you start the
Softcopy Librarian. If you do not save your password, you must enter it every time you start the
Softcopy Librarian.

f.Inthe FTP site commands field, enter defaults for any other type FTP site commands that your
installation requires. Enter a complete command, for example:

SITE DCB=xxx

These site commands are typically used for allocating data sets. Type one command per line.
g. Click onthe File types tab or the Next> button.

The File types window appears.

5.Inthe File types window, click on the BOO choice in the pull-down list or the Next button. In the
Directories containing books field, type the one or more paths to the directory that contain
your books. For example:

/u/your-ID/books

6. Click on the BKI choice in the pull-down list or the Next button. In the Directory containing
indexes field, type the path to the directory that contains your indexes. For example:

/u/your-ID/indexes
Note: This can be the same directory that contains your books.
7. Click on the BKS choice in the pull-down list or the Next button. Do the following.

a.Inthe Directory containing shelves field, type the path to the directory that contains your
shelves. For example:

/u/your-ID/shelves

b. Click on the OK button.

8. Click on the PDF choice in the pull-down list or the Next button. In the Directories containing
PDFs field, type the one or more paths to the directory that contain your PDFs. For example:

/u/your-ID/PDFs

9. Click on the XKS choice in the pull-down list or the Next button. Do the following;:

a.Inthe Directory containing extended shelves field, type the path to the directory that
contains your extended shelves. For example:

/u/your-ID/xkshelves

b. Click on the OK button.
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10. If you are setting up the repository for use with Knowledge Center content, click on the kcCONTENT
choice in pull-down list or the Next button.

a.Inthe Directories containing KC PLUGIN CONTENT field, type the paths to the directories
in your HFS that will contain your Knowledge Center plugins. For example:

/u/your-ID/kccontent

The Knowledge Center plugins you are deploying are either directories or . jar files, depending on
the style in which they had been packaged by the content builder. They will be located in a
subdirectory of the directory specified in this field. The subdirectory name is determined by
Softcopy Librarian based on the name of the collection to which these plugins belong.

b. Click on the OK button.

11. If you are setting up the repository for use with Knowledge Center content, click on the
kcPROPERTIES choice in pull-down list or the Next button.

a.Inthe Directory containing KC PRODUCT PROPERTIES field, type the path to the directory
in your HFS that will contain your Knowledge Center product . properties files. For example:

/u/your-ID/kcproperties
You must enter only one directory.
b. Click on the OK button.
The Softcopy Librarian window reappears with the following changes:

« The Sources and Repositories window now lists the repository that you just defined.
« Anew Repository - repository-name window appears with the name you assigned.

You are done defining your repository. You can define additional repositories by repeating these
instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your
repositories. Continue with the instructions in Chapter 12, “ Creating and Recreating the Catalog for Your
Repository,” on page 45.

Setting Up a Unix-like Repository 39



40 Softcopy Librarian: User's Guide



Chapter 11. Setting Up a PC/LAN Repository

You must define at least one repository for the Softcopy Librarian to be able to manage your softcopy files.
This type of repository is intended for use with BookManager BookServer accessed from a workstation
through a Web browser. The repository definition tells the Softcopy Librarian where to look for softcopy.
You can define a repository whether or not you already have bookshelves and books installed.

This chapter describes:

« Considerations to keep in mind before setting up your repository
« Instructions for preparing your PC or LAN server
- Defining the repository to the Softcopy Librarian

Considerations for Setting Up Your Repository

Here are some things you need to know about your repository on LAN server or PC hard drives:
« You can define your repositories in several ways. For example:
— Define a single repository in a single directory, into which you would put all your softcopy files. .
— Define a single repository in multiple directories.
- All the shelf file types must be in the same directory.
- File types can be either in separate directories or in combined directories
— Define multiple repositories, provided they are each in separate directories from each other.

« If you already have files for a repository installed in multiple directories, you must delete them and
reinstall them in a single directory.

- If you add or remove softcopy items from your repository without using the Softcopy Librarian, you must
recreate the catalog.

The Softcopy Librarian will not recreate it automatically for you, and, therefore, it will not be able to
recognize your changes.

Setup Required for Your Repository

If the repository is on a LAN, ensure you have read/write access to the necessary directories.

Defining a PC or LAN Server Repository

To define a repository on a PC or LAN server, do the following:

1. On your workstation, start the Softcopy Librarian. (Refer to Chapter 5, “Starting the Softcopy
Librarian,” on page 13.)

2. Inthe Sources and Repositories window inthe Softcopy Librarian window, do the
following:

a. Click on File on the task bar.
b. In the pull-down window that appears, click on the New choice.
c. In the pop-up window that appears, click on the Repositozry choice.
The Repository Properties - New Repository window appears.
3.Inthe Repository Properties - New Repository window, do the following:
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a. Type a name for this new repository in the Repository Title field.

Note: The name you type here can be anything you want. It is the name that the Softcopy Librarian
uses on your workstation to refer to your repository.

b. Select the Location and method of accessing for this repository by clicking on the Local or
network drive via COPY commands button.

c. Click on the File types tab or the Next> button.

The File types window appears.

4. Inthe File types window, do the following:

10.

. Click on the BOO choice in the pull-down list or the Next button. Do the following:

a. Required: Inthe Directories containing books field, type the one or more paths to the
directory that contain your books. For example:

\u\your-ID\books

. Click on the BKT choice in the pull-down list or the Next button. Do the following:

a. Required: In the Directory containing indexes field, type the path to the directory that
contains your indexes. For example:

\u\your-ID\indexes

Note: This can be the same directory that contains your books.

. Click on the BKS choice in the pull-down list or the Next button. Do the following:

a.Inthe Directory containing shelves field, type the path to the directory that contains your
bookshelves. For example:

\u\your-ID\shelves

b. Click on the OK button.

. Click on the PDF choice in the pull-down list or the Next button. Do the following:

a. Required: In the Directories containing PDFs field, type the one or more paths to the
directory that contain your PDFs. For example:

\u\your-ID\PDFs

. Click on the XKS choice in the pull-down list or the Next button. Do the following:

a.Inthe Directory containing extended shelves field, type the path to the directory that
contains your extended shelves. For example:

\u\your-ID\xkshelves

b. Click on the OK button.
If you are setting up the repository for use with Knowledge Center content, click on the kckCONTENT
choice in pull-down list or the Next button.

a.Inthe Directories containing KC PLUGIN CONTENT field, type the paths to the directories
in your HFS that will contain your Knowledge Center plugins. For example:

/u/your-ID/kccontent

The Knowledge Center plugins you are deploying are either directories or . jar files, depending on
the style in which they had been packaged by the content builder. They will be located in a
subdirectory of the directory specified in this field. The subdirectory name is determined by
Softcopy Librarian based on the name of the collection to which these plugins belong.

b. Click on the OK button.
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11. If you are setting up the repository for use with Knowledge Center content, click on the
kcPROPERTIES choice in pull-down list or the Next button.

a.Inthe Directory containing KC PRODUCT PROPERTIES field, type the path to the directory
in your HFS that will contain your Knowledge Center product . properties files. For example:

/u/your-ID/kcproperties
You must enter only one directory.
b. Click on the OK button.
The Softcopy Librarian window reappears with the following changes:

« The Sources and Repositories window now lists the repository that you just defined.
-« Anew Repository - repository-name window appears with the name you assigned.

You are done defining your repository. You can define additional repositories by repeating these
instructions for each new repository.

When you have finished defining all your repositories, you are ready to create the catalog for your
repositories. Continue with the instructions in Chapter 12, “ Creating and Recreating the Catalog for Your
Repository,” on page 45.
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Chapter 12. Creating and Recreating the Catalog for
Your Repository

This chapter describes:
« How the Softcopy Librarian updates the catalog for your repository automatically when you use it to:
— Transfer softcopy files to the repository
— Perform routine maintenance on your repository.
« When and how you must erase the cache that the Softcopy Librarian uses
« How you must create or recreate the catalog manually for your repositories after you:
— Set up the repository for the first time
— Make manual changes to the contents of your repositories

For example, you might have:

- Unloaded shelves, books, and indexes from tape directly into your repository
- Copied softcopy files manually into your repository
- Deleted softcopy files manually from your repository
— Change the definition of a repository
— Erased the cache used by the Softcopy Librarian
— Receive certain errors that can cause a mismatch between the catalog and its repository.

Note: If you haven't already defined a repository on your host, you must define one before you can create
a catalog for it. Refer to Chapter 8, “Setting Up a z/OS or 0S/390 Host Repository Using Sequential Data
Sets,” on page 27, Chapter 9, “ Setting Up a z/OS or 0S/390 Host Repository Using the Unix System
Services HFS,” on page 33, Chapter 10, “ Setting Up a Unix-like Repository,” on page 37, or Chapter 11,

“ Setting Up a PC/LAN Repository,” on page 41, for instructions before you continue.

If you are creating a catalog for the first time or recreating it after you have made manual changes to your
repository, you can continue with the instructions in “Creating or Recreating the Catalog Manually” on
page 46.

If you are routinely transferring Knowledge Center content or shelves and associated publications to your
repository or maintaining it, refer to “Updating Your Catalog Automatically” on page 45.

Updating Your Catalog Automatically

After you have set up your repository and created its catalog for the first time, you are ready to transfer
content routinely as you receive them on CDs or as they appear on the IBM Web site.

When you transfer content using the Softcopy Librarian, the catalog is updated automatically to reflect
the changes the transfer made to the repository. You do not need to recreate the catalog. For routine
transfers to your repositories, refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for
instructions.

When you maintain your repositories using the Softcopy Librarian, the catalog is also updated
automatically for you. You do not need to recreate it. The Softcopy Librarian allows deletion of old and
out-dated files from your repositories. For day-to-day maintenance of your host repository, refer to
Chapter 14, “Maintaining Your Repositories,” on page 51 for more information.
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Creating or Recreating the Catalog Manually

There are times when you must create or recreate a catalog manually for your repositories:
- If you are creating a catalog for the first time
« If you have made any manual changes to your repository or its contents.
To create a catalog for your new host repository or to recreate it, do the following:
1. On your workstation, start the Softcopy Librarian.
2. In the Sources and Repositories window, do the following:
a. Select the repository for which you want to recreate its catalog.
b. Select the File option on the task bar.
c. In the File menu, Select the Create catalog.

The creation of the catalog may take quite a while if there are many files in the repository. As the
catalog is created or recreated, you will see several messages appear in the Softcopy Librarian
Messages window. The ones you may notice are:

: 125 List started OK.
: Analyzing directory ..

The following set of messages appear for each shelf that is processed:

Processing shelf 0000 dataset-name ..

Adding shelf filename to catalog

A pop-up window appears with a message that the catalog has been created.
3. Click on the OK button.

The catalog is created and the Softcopy Librarian window reappears.
In general, catalog creation:

- Lists in the catalog all files specified by the high-level qualifiers and directories.

- Reads the files to determine their contents.
Each time an index file is used in a shelf, the reference count for that file is incremented by 1. A file's
reference count indicates how many shelves contain that file.

- Writes into the catalog, the list of files, and other information that is stored on the workstation.

« For 0S/390 Sequential Data Sets Only: Creates a shelf list (BKLSHELF data set) and stores it on the host
using the high-level qualifier you specified. This list contains the names of all the shelves that are being
managed by the Softcopy Librarian.

After you have created or recreated the catalog for your repository, you should define a default location
from which you will be transferring softcopy files. Refer to the instructions in Chapter 13, “Identifying the
Sources of Content That You Want to Transfer,” on page 49.

When and How to Erase the Cache That the Softcopy Librarian Uses

A copy of each of your shelves or Knowledge Center . zip files is kept in the cache directory on your
workstation. When the Softcopy Librarian reads a shelf or Knowledge Center content, it reads it from the
cache directory rather than transferring it from the repository. This saves accessing time.

If changes are made to the shelf or Knowledge Center content files in your repository, you must also erase
the cache that the Softcopy Librarian uses and then recreate the catalog for the repository. Otherwise, the
Softcopy Librarian will not be aware of the changes made and will read an older copy from the cache.
These changes include:
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- Editing a Shelf file to change the title.

Note: If you want to edit the title of the Shelf, you should use the Edit Title choice under the Edit option
in the Shelf view.

« Rebuilding the Shelf without changing its file name
To help the Softcopy Librarian keep track of these changes, do the following:
1. Start the Softcopy Librarian.
2. In the Sources and Repositories window, do the following:
a. Select the repository you modified.
b. Select the File option on the task bar.
c. In the File menu, select Erase cache.
d. Select the File option again on the task bar.
e. In the File menu, select Create catalog.
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Chapter 13. Identifying the Sources of Content That
You Want to Transfer

Before you can transfer softcopy to your repository for the first time, you must identify their source to the
Softcopy Librarian. This chapter describes how to identify the sources from which you plan to transfer to

your repositories routinely. The Softcopy Librarian lets you define any of the following sources, which you
can change at any time. You can define:

« A CD-ROM drive (for transferring from CD collections)

« An Internet Web site that supports the Softcopy Librarian (for transferring from IBM PUBLIB and other
Web sites)

« A LAN server hard drive (for transferring softcopy that was created or collected by various means)

« Alocal PC hard drive (for transferring softcopy that you created).

Note: Transferring from an Internet site is only available from Windows workstations, it is not available
with OS/2 workstations.

Use the Softcopy Librarian's Automatic check for updates function. This is available from the
Softcopy Librarian, choicein the Start menu orin the Softcopy Librarian's Help. With this, you
should be able to download from the Internet.

Identifying a CD Reader or Hard Drive as the Source

To identify a source from which you want to transfer, do the following;:

1. On your workstation, start the Softcopy Librarian.
2.Inthe Sources and Repositories window, do the following:

a. Click the File choice on the task bar.
b. In the File menu, click New.
c. Inthe New menu, click Souzrce.

The Source Properties - New Source window appears.
3. Inthe Source Properties - New Source window, do the following:

a. Type aname in the Source title field.

This can be any name you choose. The Softcopy Librarian uses this name to identify this source on
your workstation.

b. Identify the type of the source you want to use. Do one of the following:

« If you want to use a CD-ROM or hard drive as a source, select the Install softcopy from a CD or
hard drive button, supply the path to the drive in the Softcopy file path field.

- If you want to use an Internet site as a source, select the Install softcopy files from the
Internet button, and supply the URL of the Internet site in the URL address of Internet
site field. The default URL (http://publib.boulder.ibm.com)shown is the address of the
IBM PUBLIB Web site.

Note: We do not generally recommend that you routinely use a web site to maintain your
repositories. Depending upon the speed of your Internet access, downloading can take
substantially longer than transferring from CDs or a local hard drive.

If your Internet access is relatively slow, we recommend that you continue to use the IBM CD
collections to set up your repositories initially and for your normal quarterly refreshes, and use
the Internet only as follows:
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— Between quarters to obtain any softcopy files that might have missed the collections.

— Near the end of the quarter to obtain a few critical softcopy files early prior to their release on
the CD collections

— If you do not have access to the CD collections.
If you have high-speed Internet access, you can try maintaining your repositories each quarter
from a web site.

c. Click the OK button.

You are now ready to transfer from your CD reader, a hard drive, or the Internet to your repository.
Continue with the instructions in Chapter 14, “Maintaining Your Repositories,” on page 51

50 Softcopy Librarian: User's Guide



Chapter 14. Maintaining Your Repositories

This chapter describes how to transfer content to your repositories and maintain them.
You can:
« Maintain one or more repositories separately

You can transfer new and updated softcopy files to each repository and manually delete from each
repository files that have newer replacements.

« Maintain one repository and several identical copies

If you need to create and maintain several identical repositories, you can transfer to one repository and
maintain it as a model. Then you can transfer files to one or more repositories independently of each
other, maintain them separately, but "synchronize" their contents.

Transferring Content to a Repository

You can add or update shelves or Knowledge Center for z/OS content to your repository by transferring it
from your SoftCopy Librarian sources. You can update your repositories separately. This means you must
go to each repository and make any changes that you want.

Before you begin

If you have not defined the sources or repositories that you intend to use, refer to the instructions in
Chapter 13, “Identifying the Sources of Content That You Want to Transfer,” on page 49 to define your
sources or Chapter 8, “Setting Up a z/OS or 0S/390 Host Repository Using Sequential Data Sets,” on page
27Chapter 9, “ Setting Up a z/OS or 0S/390 Host Repository Using the Unix System Services HFS,” on
page 33, Chapter 10, “ Setting Up a Unix-like Repository,” on page 37, or Chapter 11, “ Setting Up a
PC/LAN Repository,” on page 41 to define your repositories before you can continue. After you have
defined your sources and repositories, return here and continue with these instructions.

About this task

To begin the process of maintaining a repository, you should decide when it is appropriate to transfer to a
repository. You could choose to update a repository when you:

« Receive a new CD-ROM collection

« Notice that new or updated versions of softcopy files appear on your source Internet site

Procedure

To transfer content to a repository:
1. If you are using a CD-ROM source, insert the correct CD in your CD reader.

2. Start the SoftCopy Librarian.
The Source and Repositories window opens. If you had previously opened any of your source or
repository windows, those windows will also be open.

3. Select the source from which you want to update your repository.

« If the source window you want is not already open, you can select it from the Sources and
Repositories window by double-clicking on the source you want to open or single-clicking on
the source you want to open and selecting Open from the File menu on the task bar. The SCL
Repository List window will appear with a list of your current repositories.

Alternatively, in the SCL Repository List window, select the repository that you want to update
from the source selected. The SoftCopy Librarian will compare the contents of the source you
selected with the repository you select in this window and will update the status of the items in the
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source. The updated status in the source window will indicate which items are potential candidates
for updating the repository. The source window you selected will open with an updated status.

- If your source window is already open, then in the Source - Title window, select Update Status:
Compared to from the File menu. Select the repository that you want to update from the list of your
current repositories. The SoftCopy Librarian will compare the contents of that source with the
repository you select and will update the status of the items in the source window. The updated
status in the source window will indicate which items are potential candidates for updating the
repository. The source window you selected will open with an updated status.

4. In the Source - Title window, identify the items that you want to transfer to your repository.
You can filter the list to only show the items that are new or changed. Use the Show New/Updated
choice in the Options menu in the source window.

You can sort the list so that all new and updated entries are clustered together. Single click on the
heading of the Status column. The contents of the status column will be sorted alphabetically. All the
"Updated,” "New," "Installed," and so on, entries to be grouped together in the same order (ascending
or descending) as the Title column is sorted. If you click on the heading a second time it will change
the sort to the opposite sort order. You can sort any of the other columns in the same way.

5. Select the items that you want to transfer.
You can select and deselect items in several ways:
Select a single item:
Left-click on any item. This will deselect any other items that have been selected.

Select several items:
Press and hold the Ctrl key and left-click on the items you want. You can deselect in the same way.

Select all the items:
Use the Select All choice in the Options menu. This choice is handy if you have filtered the list first
to show only new and updated items.

Deselect all the items
You can deselect all that you have selected with the Deselect All choice in the Options menu in
the source window.

6. When you are satisfied with your selections, transfer the items that you selected to the repository you
want to update.

You can transfer in the following ways:
« Use the Send to choice in the File menu in the source window.

- Right-click in the source window, select the Send to choice, and the repository that you want to
update.

A Attention: If you have selected several, you must not release the Ctrl key before you right-
click or your choices will be deselected.

The Repository - Title window for the repository you selected appears. The items you transferred now
appear.

Results
After you have transferred to a repository you can perform maintenance on the contents such as removing
any old files that were replaced by new versions.

Maintaining a Repository

After you have transferred to your repositories, you can:

« Maintain each repository by removing old versions for which there are new replacements
« Maintain one repository as a model and transfer copies of the model to identical repositories.
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When you are ready to maintain a repository, you can do the following:

1. Inthe Repository - title window, make sure that you are using the Shelves view.

Note: We recommend that you work from the Shelves view, and always delete books by deleting
their shelves.

When you delete associated publications, if the reference count goes to 0, those associated
publications are automatically deleted along with the shelf.

We recommend that you only use the Files to locate and delete "orphaned" associated publications.
Orphans have a reference count of "0" in the list.

2.Inthe Repository - title window, identify the shelves that you want to delete.

Items that are potential candidates for deletion are identified by the filename of their newer version in
the Replaced by column. For example:

Title

Filename Replaced by

| |
DB2 for 0S/390 V5 |
QMF V3R1.1 for MVS | dsqms004 | dsqms006
| |
| |
| |

QMF V3R2 for MVS dsgms006 | dsgms@07
QMF V3R3 for MVS dsqms007
DITTO V2 for MVS dutba®0
DataHub for 0S/2 V2R1.0 emqsh00O3
dpAccounting Manager/MVS R1.2| eoubks0l | eoubks02
dpAccounting Manager/MVS eoubks02

| |
| |
OPC/ESA R2.0 | eqq2bs00 | eqq2bs02
| |
| |
| |

OPC/ESA R2.1 eqq2bs02
OPC/ESA R1R3.1 eqq3bs04
CallPath CICS/MVS eqzmsh00

dsnsh0f2

You can analyze the candidates in one of two ways:

Simply sort the list so all shelves that can be replaced are clustered together. Single click on the
heading of the Status column. The contents of the status column will be sorted alphabetically. All
the "Replaced by" entries will be grouped together in the same order (ascending or descending) as
the Title column is sorted. If you click on the heading a second time it will change the sort to the
opposite sort order. You can sort any of the other columns in the same way. This method works;
however, it may miss some shelves which do not follow the file naming conventions.

We recommend that you use this, more thorough method. Sort on the Filename column. Scroll
down to a row that has a filename in the Replaced by column. The filename in the Replaced by
column should match the filename in the Filename column in the next row. For example:

Title | Filename | Replaced by |
| | |

dpAccounting Manager/MVS R1.2| eoubks0l | eoubks02 |
dpAccounting Manager/MVS | eoubks02 |

If the names in the Title column match, the newer file is actually a replacement for the older one.
If the titles do not match, the file name of the apparent "newer" shelf probably does not conform to
the file naming conventions and is not an actual replacement.

3. Select the items that you want to delete.

You can select and deselect in several ways:

Select a single item: Left-click on any item.

This will deselect any other items that have been selected.

Select several items: Press and hold the Ctrl key and left-click on the shelves you want.
You can deselect items out in the same way.

Select all the items: Use the Select Al1l choice in the Options menu.

Deselect all the items: Use the Deselect All choice in the Options menu.
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4. When you are satisfied with your selections, delete what you selected.
You can delete in the following ways:

« Use the Delete choice in the File menu in the repository window.
« Right-click in the repository window and Select the Delete choice.

Note: If you have selected several items, you must not release the Ctrl key before you right-click or
your choices will be deselected.

A confirmation window will appear.
5. In the confirmation window, click the Yes button.

The items you selected are removed from the repository.

After you have maintained your repository, you can use this repository as a model to create identical
repositories.

Replacing or Excluding Associated Files

Occasionally, a Shelf in one of your repositories might be missing a Book. If that happens, you might see
any of the following:

« A Shelf listed in one of your source windows has a status of "Partial" when compared to one of your
repositories. The corresponding shelf in your repository is missing an associated file.

« A Shelf listed on the Shelves tab of one of your repositories appears in "red". The Shelf is missing one
or more books.

- Afile listed on the Files tab of one of your repositories appears in "red". The file is missing from its
Shelf.

The reference count for a missing associated file is negative and the number indicates the number of
shelves that are missing that file.

Title | Filename | Replaced by | Filetype|Count|
| | | | |

08/390 V2R10 AS Configuration| asumwa20 | | BOOK | -2

Note: The shelves that are missing the book appear in "red" on the Shelves tab.

You can replace the missing associated files from the IBM PUBLIB server on the Internet or you can
exclude the missing associated file permanently. Excluding a file here actually removes it from the Shelf.
It will not be listed in your repository, and BookManager will not be able to find it in the Shelf.

Replacing Missing Books
To replace a missing associated file from the IBM PUBLIB server on the Internet, do the following:

1. Click on the Files tab.

2. Highlight the file (shown in red) that you want to replace.
3. Click on the Files choice on the menu bar.

4. 1Inthe Files menu, select Download from Intezrnet.

The associated file is replaced and it and its shelf will no longer appear in "red".

Excluding Missing Books
To exclude a missing associated file from its shelf, do the following:

1. Click on the Files tab.
2. Highlight the associated file that you want to exclude.
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3. Click on the Files choice on the menu bar.
4. Inthe Files menu, select Exclude from shelf.

It will no longer appear in the list and the shelf will not appear in "red".

Removing Orphaned Associated Publications

You might also want to identify and eliminate orphans. Orphaned documents files are not part of any shelf
and, therefore, do not show up in a list when you want to locate and view files. They also take up space in
your repository that you might need.

Note: While you can leave orphans in your repository, you can only view by opening them specifically by
their filename.

To remove orphans, do the following:

1. Start the SoftCopy Librarian.

2. Open the Repository - title window for the repository that you want to review.
3. Click on the Files tab.

4. Look for books with a O reference count:

Title | Filename | Replaced by | Filetype|Count]

| | | | |
b5/390 V2R7 Encina Bookshelf | asumyal® | | BKSHELF | -
QS/390 V2R8 LANRES Install Gd| ewx1c205 | | BOOK | 0]
IBM Softcopy Reader User's Gd| hlcrug@l | | BOOK | 1]

You can scroll down the list or you can sort the Count column in the list. Sorting will bring books with a
reference count of 0 to the top of the list.

5. Highlight the orphans.
6. Click on the File choice on the menu bar.
7. Inthe File menu, choose Delete.

A confirmation window appears.
8. In the confirmation window, click the Yes button.

Maintaining Your Repositories 55



56 Softcopy Librarian: User's Guide



Chapter 15. Creating/Managing Your Own Softcopy
and Associated Publications

This chapter describes how you can create your own softcopy shelves and associated publications and
manage them with the Softcopy Librarian. It describes how to:

« Name your files so the Softcopy Librarian can manage them
 Create an exception file if you need one to resolve naming differences

Create shelves and associated publications

Transfer from a non-IBM CD to your host repository

Transfer from your hard drive to your host repository

Naming Your Files So the Softcopy Librarian Can Manage Them

IBM developed and uses a file naming convention as a way to produce and distribute softcopy files that
would have unique names.

This naming scheme has three purposes.

1. It prevents us from overwriting our own files that we ship to you.
2. It helps to ensure that IBM files don't overwrite your files

3. It provides enough file information so the Softcopy Librarian can manage shelves and associated
publications.

As you know, IBM has reserved file names beginning with the letters A-I and Q for the files that we

distribute. These conventions apply to both software and softcopy files. You are free to use the remaining

letters for your filenames without fear that we will interfere with them. To ensure that this happens, all
IBM software products are assigned a 3- or 4-character product ID. Hardware product and non-product

related documents are assigned IDs reserved specifically for that purpose and these IDs serve the same

function as product software product IDs. For example:

AFB
VS FORTRAN

ADM
GDDM

DSN
DB2

IEA
0S/390 MVS

How Files Are Named

All that having been said as background, the current naming scheme for softcopy documents is as follows:

PPP BBB R S
or

PPPP BB R S

Where:
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PPP or PPPP
Is the product ID or site assigned ID. This remains for the life of a version and is changed when there
is a new product version. This is usually not applicable to non-product related documents, which
usually retain their original for entire the life of the document.

BBB or BB
Is the publication ID, which is unique in the product library. This remains for the life of the publication.
When there is a new product version, this ID can be changed as well.

Note: The first 6 characters must remain unchanged for the life of the publication. For our product, the
life begins with a new version of the product and ends when that version is replaced.

Is a release identifier that denotes the release of the product. This number begins at 0 and is
incremented by 1 up to 9 then to A and by one letter up to Z each time the release number of the
product is incremented. This number or letter need not correspond with number of the release, it just
needs to start at 0 and increment each time a new release is made available. This would not apply to
non-product-related publications. For non-product publications this identifier should be set to 0
initially and should remain at 0 unless it is incremented because an older edition should remain
available and may be updated along with the newer version.

Is the sequence number that denotes level. This number begins at 0 and is incremented by 1 up to 9
then to A and by one letter up to Z each time the publication is updated.

This scheme is designed to prevent an older publication ending up with a higher sequence number than a
newer one. It provides for up to 36 levels for any single release and for up to 36 releases of a product.
Hopefully, this will accommodate most situations.

Important: Some older publications might follow an earlier naming scheme as follows:
PPP BBB SS
or

PPPP BB SS

Because these filenames are currently created, maintained, and processed manually by the owners and
the IBM Softcopy Center, over time and for various reasons, exceptions have crept into the practice of file
naming. For example:

- Some filenames incorporate a release indicator somewhere in the book ID, which changes the ID over
the life of the publication.

- Some filenames do not strictly increment the sequence number each update, resulting in a
discontinuous series of numbers.

« Some filenames use only 7 character positions instead of 8.

- Some filenames only increment the last digit of the sequence number using the next to last for some
other purpose.

- Some filenames for updates to older levels have ended up with a higher sequence number than the
newer level.

« And some other variations.

What If Your Old Shelf Names Do Not Work with the New Conventions

Over time and for various reasons, your practice of naming your shelves might have created file names
that are incompatible with the Softcopy Librarian's conventions.

You might also have file naming exceptions for the following reasons:

« You are combining two or more shelves into one
 You are splitting a shelf into two or more shelves.
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We strongly recommend that you convert your file names to the Softcopy Librarian's conventions. If you
are converting from your current naming convention, and, if for any reason, you have file names that
cannot conform, you can create an exception file to identify which new file names replace the old file
names. The Softcopy Librarian uses this exception file to reconcile any naming differences when your
customers transfer to their repository.

In general, you will need an exception file, whenever you have two related shelves, usually where one is a
later version of the other, and:

« The first six characters of their file names do not match

The later file will appear to the Softcopy Librarian as if it were unrelated to the earlier one.

« The first six characters match, but the last two characters (the sequence number or the RS value) of
later file name are not numerically higher than the earlier one

The later file will appear to be older than the earlier one.

If you need an exception file, continue with the instructions in “Creating an Exception File” on page 59.

Otherwise, continue with the instructions in “Creating Your Own Shelves and Books with BookManager”
on page 61.

Creating an Exception File

You might need to create an exception file for any of the following reasons:

« You have old file names that cannot be reconciled with the new conventions, and you want to convert
them.

The Softcopy Librarian cannot determine from the file names that an updated Shelf is related to an older
one that it replaces. For example:

01ld Name New Name
BAD1NAME .BKS OKNAMEOO.BKS

The entry in the exception file would look like this:

OKNAMEOGO.BKS BADI1NAME.BKS

Note: The first entry on each line is the file name of the new file. The second entry is the file name of
one or more files that are replaced by the new Shelf. Each entry is separated by at least one blank
character.

« You are combining two or more shelves into one.

The Softcopy Librarian cannot decide which shelves are being replaced by the combined bookshelf. For
example:

0ld Names New Name
ONEBKS02.BKS UNIBKSOO.BKS
TWOBKS02.BKS

The entry in the exception file would like this:

UNIBKSO0.BKS ONEBKS02.BKS TWOBKSO2.BKS

You could, in this case, retain one of the old names for new file. For example, you could name the new
file:

01ld Names New Name
ONEBKS02.BKS ONEBKSO3.BKS
TWOBKS02.BKS
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Then, your exception file would need an entry for only one of the old files. The entry in the exception file
would like this:

ONEBKSO3.BKS TWOBKSO02.BKS

« You are splitting a shelf into two or more files.

The Softcopy Librarian cannot decide which Shelf is being replaced by the new, separated shelves. For
example:

0l1ld Name New Names
OLDBKS03.BKS NEWONEGO.BKS
NEWTWOOO . BKS

The entries in the exception file would like this:

NEWONEOO.BKS OLDBKSO3.BKS
NEWTWOOO.BKS OLDBKSO3.BKS

You could, in this case, retain the old name for one of the two new files. For example, you could name
them as:

01ld Name New Names
OLDBKS03.BKS OLDBKS04.BKS
NEWONE®O . BKS

Then, your exception file would need only one entry for the Shelf with a completely new name. The
entry in the exception file would like this:

NEWONEOGO.BKS OLDBKSO3.BKS

To create an exception file, do the following:
1. Using an appropriate text or word processor, create a simple flat-text file with the name:
EBRSCL.EXC

Each line in this file represents the naming exception for one shelf.
2. For multiple shelves, enter each exception on a separate line.

The first entry on each line is the file name of the new Shelf. The second entry is the file name of one or
more that are replaced by the new Shelf. Separate each entry by at least one blank character.

Your exception file might look like this:

OKNAMEOQO.BKS BADINAME.BKS
UNIBKSO0.BKS ONEBKSO2.BKS TWOBKSO02.BKS
NEWONEOO.BKS OLDBKSO3.BKS
NEWTWOOO.BKS OLDBKSO3.BKS

The entries in this example represent the changes:

« On the first line of the example, a new version of a file (OKNAMEO0O.BKS) replaces an old version with
an incompatible name (BADNAME1.BKS).

« On the second line of the example, two old files (ONEBKS02.BKS and TWOBKS02.BKS) have been
combined into a single new file (UNIBKS00.BKS), and the new file replaces both older ones.

« On the third and fourth lines of the example, an old file (OLDBKS03.BKS) has been split into two new
files NEWONEO0O.BKS and NEWTWOO00.BKS), and both new files replace the old one.

3. For workstation users: Copy the exception file that you want on the media to the \SCRT\EXCEPT
directory.

For host terminal users: Download the exception file to the \SCRT\EXCEPT directory on the
workstation you will use to create the media.

Note: You must down load the exception file as an ASCII file.
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You are now ready to build the BookManager versions of the files you intend to distribute and to create
shelves and indexes for them.

Creating Your Own Shelves and Books with BookManager

To create BookManager books and shelves, do the following:

1. Create a naming scheme for your books, shelves, and indexes that generally conforms to the file
naming conventions described in “Naming Your Files So the Softcopy Librarian Can Manage Them” on
page 57.

Note: You can use any first six characters you choose. Ensure that the first character does not conflict
with the letters that IBM uses. You must adhere to the conventions for the last two characters.

2. Using an appropriate text or word processor, create source files for your books that are acceptable to a
BookManager BUILD program. Refer to the BookManager BUILD for Windows manuals for the source
coding that is acceptable.

3. Format your books for viewing using a BookManager BUILD program. Refer to the BookManager BUILD
for Windows manuals for instructions on building books.

4. Decide how you are going to organize your books into shelves.
5. Create a Shelf and Index for each set of books you want in a separate Shelf.

6. Use the same filename for the Shelf and the Shelf Index. Refer to the BookManager BUILD for
Windows manuals for instructions on creating shelves and indexes.

7. Use Softcopy Reader Organizer or Library Server to build a Shelf containing the new Books and Index.

For BUILD for Windows users: After you have built your books and created your shelves and indexes, you
are ready to transfer them to your host repository. Refer to Chapter 13, “Identifying the Sources of
Content That You Want to Transfer,” on page 49 and Chapter 14, “Maintaining Your Repositories,” on page
51 for instructions on setting your default source location and transferring your files.

For BUILD/MVS users: If you built you books, shelves, and indexes on your 0S/390 host and you are
using a host repository, you can copy your files directly into host repository. Refer to Appendix D,
“Managing Changes to Your Repository,” on page 69 for instructions on manually updating your host
repository and recreating its catalog.
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Appendix A. Permitting More Then One Person to
Maintain Your Repositories

Installing Softcopy Librarian on a server allows several customers, through shared access, the ability to
maintain the same repositories.

1. Install the Softcopy Librarian in a directory which is on a drive shared by all customers with whom you
want to be able to maintain your repositories.

All customers must have read/write access and authorized IDs to the shared drive.
2. Have one of the customers access the shared directory and do the following:
a. Start the Softcopy Librarian.
b. Inthe First time window, if there are any files to be migrated, migrate them now.
c. Define their (the customer's) CD-ROM drive letter.
3. Have each of the other customers, start the Softcopy Librarian.

4. Inthe First time window, do not attempt to migrate any repositories, but have your customers
define their default CD-ROM drive letter.

5. For any repositories that will require FTP for processing, have your customers update the
Repositories Properties - FTP Logon Information window with their userid and
password. This information will be maintained at the individual workstation level.

Each customer will have their own sources but will be able to share access to and maintain the same
repositories. They each can create new repositories, and the repositories will be accessible to everyone.

Because there is no file locking, only one customer should work with a repository at a time. This is a
manual enque/deque procedure.
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Appendix B. Changing the Definition of Your
Repository

You can change the definition of a repository for several reasons:

« You may want to change the following attributes of your repository:

High-level qualifiers or directories

SMS classes

DASD device

DASD volume

FTP site commands

« You may want to share the administration of your repository with others

Changing the Attributes of Your Repository

To change any of the attributes of a host repository that you previously defined, do the following:

1. Start the Softcopy Librarian.

2. From the Sources and Repository window - select a Repository to update.
3. Select File, then Properties.

4. The Repository Properties - Repository Name window appears.

« Make your changes in the windows and select OK.
5. If you change the following items in the definition of your repository:

« The location of the repository (HLQs or directories)
Theninthe SoftCopy Librarian panel, you must recreate the catalog for your repository:

« From the Sources and Repository window - select a Repository to update.
« Select File, then Cxreate Catalog.
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Appendix C. Deleting a Repository

To delete the softcopy files and the repository definition, do the following:

1. Start the Softcopy Librarian.
2. From the Sources and Repositories window:

a. Select a repository to delete.
b. Select File, Open
3. Inthe Repository - Title window:

a. Select options, select ALL to highlight all the shelves
b. Select File, Delete.
c. Inthe Confirmation window, select Yes

The shelves and files should disappear from the Repository - Title window.
4. Return to the Sources and Repositories window and do the following:

a. Select the repository to delete.
b. Select File, Delete
c. In the confirmation window, select Yes.

The repository will disappear from the Sources and Repositories window.
To delete only the repository definition, do the following:

1. Start the Softcopy Librarian.
2. From the Sources and Repositories window:

a. Select a repository to delete.
b. Select File, Delete
c. In the confirmation window, select Yes.

The repository will disappear from the Sources and Repositories window.
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Appendix D. Managing Changes to Your Repository

This appendix explains how the Softcopy Librarian can help you manage:

« Shelves and associated publications that you unload from tape or copy directly into your repository.
« Changes made to the shelves in your repository.

Unloading or Copying Softcopy Files from Tape or other Sources

When unloading softcopy files from tape or other sources, complete the following steps so that these files
can be managed by Softcopy Librarian.

1. Make sure that you have followed the procedures for setting up your host and defining your host
repository to the Softcopy Librarian described in Chapter 8, “Setting Up a z/OS or 0S/390 Host
Repository Using Sequential Data Sets,” on page 27.

2. Unload the tapes or copy the files to the HLQ or directory that you are using for your repository.

3. Start the Softcopy Librarian.
4. In the Softcopy Librarian window, do the following:

a. Inthe Sources and Repository window, select the repository you updated.
b. Select File, create catalog.

When the catalog has been created, the update is complete.

Item Changes in Your Repository

If any additions or changes to the files in your repository are made outside of Softcopy Librarian, then you
must erase the cache that the Softcopy Librarian uses and recreate the catalog for the repository.

To help the Softcopy Librarian keep track of these changes, do the following:

1. Start the Softcopy Librarian.
2. Inthe Sources and Repository window, select the repository to be updated.

3. Select File, erase cache.
« Atthe Confirm Dialog window, select Yes.
Cache will be erased and the Catalog Function will be performed.

When the catalog has been created, the update is complete.
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Appendix E. Summary of Changes Made in Previous
Editions

This appendix summarizes the major changes made in the previous editions.

Changes made to the Seventeenth Edition

Updated Softcopy Librarian for Windows Vista Support

Installed an icon on the Windows desktop for IBM Softcopy Librarian.

Changes made to the Sixteenth Edition

Updates made to the following areas:

« Updated the IBM Web site for downloading the latest version of Softcopy Librarian
« Included miscellaneous editorial updates

Changes made to the Fifteenth Edition

Updates made to the following areas:

« Hardware and software requirements

« Information about Library Server

- Updates to how PDF files are handled

« Updates to Maintaining Your Repositories

Changes made to the Fourteenth Edition

Updates made to the following areas:

« Hardware and software requirements
« Internet connection
- Migration from previous versions of Softcopy Librarian

Changes made to the Thirteenth Edition

Removed support for Windows NT 4.0, and replaced the URL for the IBMLink Web site. editions of the
Softcopy Librarian: User's Guide.

Changes made to the Twelfth Edition

Made terminology changes regarding the new "Extended Shelf" architecture.
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Changes Made in the Eleventh Edition

- Updates to Appendixes A through D. Clarifications were made to the procedures relating to working with
repositories, such as:

More than one person maintaining your repository

Changing the definition of your repository

Deleting a repository

Managing changes to your repository

Changes Made in the Tenth Edition

« Softcopy Librarian can handle shelves and associated publications created by OEM companies that use
one of the IBM BookManager Build products.

« Updated IBM Web and e-Mail addresses for support and free downloads.
- Corrected directory path statement syntax in several examples

« Elimination of "EBRMGMT" as the default HLQ for the Shelf List (BKLSHELF) and establishing this field
as a required entry.

Changes Made in the Ninth Edition

« Miscellaneous editorial updates.

Changes Made in the Eight Edition

- The Softcopy Librarian has been rewritten in Java.

« A new user interface lets you display multiple source windows and multiple repository windows
simultaneously. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51.

« You can transfer files directly between source and repository windows and between repository
windows. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51.

Changes Made in the Seventh Edition

New Information

« The code for the current version of the Softcopy Librarian is now located in the \SCL directory on the
CDs in the IBM Online Library. Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11.

« Inthe 0S/390 Collection the Softcopy Librarian is now located on the "Tools" disc. Refer to Chapter 4,
“Installing the Softcopy Librarian,” on page 11.

- Buttons for selecting the source have been added to the Transferring softcopy to the
repository choice in the main menu of the Softcopy Librarian window.

Changes Made in the Sixth Edition

New Information

« Information on maintaining your repositories from IBM's and other Web sites have been added. Refer to
Chapter 1, “ Introducing the Softcopy Librarian,” on page 1.
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Procedures for defining the IBM PUBLIB and other Web sites as the source to transfer have been added.
Refer to Chapter 13, “Identifying the Sources of Content That You Want to Transfer,” on page 49.

Procedures for transferring files from the IBM PUBLIB and other Web sites to your repositories have
been added.

Changes Made in the Fifth Edition

New Information

Procedures for installing and starting the OS/2 version of the Softcopy Librarian have been included.
Refer to Chapter 4, “Installing the Softcopy Librarian,” on page 11 and Chapter 5, “Starting the Softcopy
Librarian,” on page 13 for more information.

Minor changes for using the 0S/2 Softcopy Librarian have been made throughout.
A method for automatically checking if a later version of the Softcopy Librarian is available from the IBM

Web site has been added to the Windows version of the Softcopy Librarian. Refer to Chapter 4,

“Installing the Softcopy Librarian,” on page 11 for more information.

Changes Made in the Fourth Edition

New Information

A check box that permits you to ignore a descriptor file that contains errors on a CD has been added to
the SCL Setup - Location of Files to Install window. Refer to Chapter 13, “Identifying the
Sources of Content That You Want to Transfer,” on page 49 for more information.

Two new choices that control whether the Ctrl key is required to make additional selections have been
added to the Options in SCRT - Shelves Viewand SCRT - Files View windows. The
Extended Selection choice requires the use of the Ctrl key and the Multiple Selection choice
does not require the use of the Ctrl key.

Changes Made in the Third Edition

New Information

Information describing how to use the "cache erase" function when you make manual changes to the
contents of your repository. Refer to Chapter 12, “ Creating and Recreating the Catalog for Your
Repository,” on page 45 for more information.

Information has been added on the automatic creation of a descriptor file for non-IBM CDs.

Information describing how to exclude "missing" files from the shelves in your repository has been
added. Refer to Chapter 14, “Maintaining Your Repositories,” on page 51 for more information.

A new section has been added describing how to create an exception file. Refer to “Creating an
Exception File” on page 59 for more information.

A new appendix has been added describing how to change to your repository definition and how to
permit more than one user to maintain your repository through the use of shared work files. Refer to
Appendix B, “Changing the Definition of Your Repository,” on page 65 for more information.

A new appendix has been added describing how to remove a repository. Refer to Appendix C, “Deleting
a Repository,” on page 67 for more information.

A new appendix has been added for independent software vendors (ISVs) who want to package and
distribute product documentation enabled for the Softcopy Librarian.

Changed Information

The method for defining host repositories using 0S/390 sequential data sets has been significantly
revised. Refer to Chapter 8, “Setting Up a z/OS or 0S/390 Host Repository Using Sequential Data Sets,”
on page 27 for more information.
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- The chapter on defining host repositories has been split into two chapters, one for repositories using
0S/390 sequential data sets and one for repositories using the hierarchical file system of 0S/390 UNIX
System Services. Refer to Chapter 8, “Setting Up a z/OS or 0S/390 Host Repository Using Sequential
Data Sets,” on page 27 and Chapter 9, “ Setting Up a z/OS or 0S/390 Host Repository Using the Unix
System Services HFS,” on page 33 for more information.

« The chapter on creating exceptions files has been combined with the chapter on creating and managing
your own shelves and associated publications. Chapter 15, “Creating/Managing Your Own Softcopy and
Associated Publications,” on page 57 for more information.

« Because the Softcopy Librarian now has the ability to automatically create descriptor files, the chapter
on creating descriptor files has been deleted from this edition.

« The chapter on distributing on media your product bookshelves and books to your customers has been
expanded and made into an appendix.

 Minor editorial changes have been made throughout this manual.

Changes Made in the Second Edition

New Information

« Hardware requirements for a repository on a LAN server or PC workstation has been added. Refer to
Chapter 2, “Hardware and Software Requirements,” on page 5 for more information.

= A new chapter has been added describing how to set up repositories on LAN servers and PC
workstations. Refer to Chapter 11, “ Setting Up a PC/LAN Repository,” on page 41 for more information.

- Information on editing names from the repository maintenance facility has been added. Refer to
Chapter 14, “Maintaining Your Repositories,” on page 51 for more information.

Changed Information

- New Web site for downloading the Softcopy Librarian code. Refer to Chapter 1, “ Introducing the
Softcopy Librarian,” on page 1 for more information.

« The information on defining an 0S/390 host repository has been reorganized. Refer to Chapter 8,
“Setting Up a z/OS or 0S/390 Host Repository Using Sequential Data Sets,” on page 27 for more
information.

« The section describing how to install the Softcopy Librarian has been revised. Refer to Chapter 4,
“Installing the Softcopy Librarian,” on page 11 for more information.

- The information describing how to start the Softcopy Librarian has been reorganized. Refer to Chapter 4,
“Installing the Softcopy Librarian,” on page 11 for more information.

- The information on using tapes has been moved into an appendix. Refer to Appendix D, “Managing
Changes to Your Repository,” on page 69 for more information.

Technical changes or additions to the text and illustrations in this edition are indicated by a vertical line (|)
to the left of the change.

74 Softcopy Librarian: User's Guide



Do You Have Questions, Problems, or Comments?

The IBM Softcopy Librarian is a free tool, supported through e-Mails as time permits. For support, send a
note explaining your question, problem, or comment to: bookmgr@us . ibm.com

The IBM Softcopy Librarian software can be downloaded without charge from the IBM Bookmanager Web
Site http://www-01.ibm.com/software/applications/office/bkmgz/.

IBM may use or distribute whatever information you supply in any way it believes appropriate without
incurring any obligation to you.
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